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Uvod

Zahvaljujemo $to ste Medtronic Diabetes odabrali za partnera koji ¢e i vama i bolesnicima olaksati

lijeCenje dijabetesa. Vjerujemo da cete imati koristi od vrhunske tehnologije softvera CareLink®

Pro i jednostavnog korisni¢ckog sucelja kojim se upravlja putem izbornika.

CareLink Pro omogucuje prikupljanje i pohranjivanje podataka o lije¢enju i dijagnostickih

podataka te izvjesc¢ivanje na temelju tih podataka. Mozete ga koristiti i za pristup podacima o

glukozi dobivenima od pumpe, mjeraca i senzora koje bolesnici prenesu u CarelLink® Personal,

mrezni sustav za pracenje terapije koji funkcionira u suradnji sa softverom CareLink Pro.

Znacajke

CarelLink Pro softver je za osobna ra¢unala namijenjen pradenju terapije za dijabetes. Raspolaze

sljedec¢im znacajkama:

Zapisi o bolesniku mogu se stvarati radi pohrane podataka prikupljenih iz bolesnikova
uredaja, kao i podataka o lije¢enju s njegova rac¢una u sustavu CareLink Personal.

Podaci iz inzulinskih pumpi, monitora i mjeraca glukoze u krvi mogu se slati sustavu,
pohranjivati i zatim koristiti za generiranje izvjesca.

Postoji i moguénost povezivanja sa sustavom CareLink Personal, pri ¢emu se omogucduje
pristup podacima s uredaja koje su bolesnici ondje pohranili. To je idealno za stvaranje
aktualnih izvjesc¢a izmedu posjeta lije¢niku te moze ocitavanje podataka s uredaja tijekom
posjeta lije¢niku uciniti nepotrebnim.

Iz podataka s uredaja koji su pohranjeni u bolesnikovu zapisu mogu se stvarati razne vrste
izvjeSca o lijeCenju. lzvjes¢a olaksavaju pronalazenje odgovora na pitanja u sklopu lijecenja,
kao $to su bolesnikovo pridrzavanje propisane terapije, obrasci i iznimke.

Sustav vas obavjestava kada su dostupna azuriranja softvera koja mozete preuzeti i instalirati.
To vam jam¢i da imate pristup najnovijim znacajkama.

Znacajka Guide Me (Vodi me) pocetnicima pojednostavnjuje koristenje softvera CarelLink Pro.
Ona nudi savjete o zadacima koje obavljaju.
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« Integrirani sustav pomocdi dostupan je u cijelom softveru i pruza informacije o specifi¢nim
podrugjima.
Sigurnost

«  CareLink Pro moze se zastititi lozinkom.

«  Prijenos podataka o bolesniku iz sustava CarelLink Personal Sifrira se pomocu standardne SSL

tehnologije.

Povezani dokumenti

Svaki od ovih dokumenata Medtronic MiniMed sadrzi informacije koje su specifi¢tne za uredaj i

koje nisu detaljno opisane u ovom korisnickom priru¢niku.

NAPOMENA: specificne informacije o mjeracima drugih proizvodaca potrazite u uputama

koje se isporucuju zajedno s mjeraéem.

«  Korisni¢ki priru¢nik za inzulinsku pumpu Paradigm

«  Korisni¢ki priru¢nik za monitor koji prati podatke u stvarnom vremenu Guardian REAL-Time
«  Korisni¢ki priru¢nik za znacajke senzora

«  Korisni¢ki priru¢nik za ComLink

«  Korisni¢ki priru¢nik za CareLink USB

Pomo¢

Ako vam je potrebna dodatna pomo¢ za ovaj sustav, obratite se lokalnom predstavniku u svojoj

zemlji. Informacije o medunarodnim kontaktima mozete pronaci na sljedecem web-mjestu:

http://www.minimed.com/contact/international-locations

Podrzani uredaji

CareLink Pro prima podatke iz sljedecih uredaja.

NAPOMENA: neki uredaji koje podrzava ovaj softver mozZda nisu dostupni u svim zemljama

u kojima je ovaj softver odobren za koristenje.
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Pumpe Medtronic MiniMed:

Monitori Guardian REAL-Time:

508

CSS-7100
CSS-7100K

Povezani mjeraci:

LifeScan:

Obitelj proizvoda Bayer Ascensia™ DEX™, ukljucujuci
ove kompatibilne mjerace:

Bayerov CONTOUR® LINK
Monitor glukoze u krvi BD Paradigm Link®

OneTouch® UltraSmart®
OneTouch® Profile®
OneTouch® Ultra®
OneTouch® Basic®
OneTouch® FastTake®
OneTouch® SureStep®
OneTouch® Ultra® 2
OneTouch® UltraMini®
OneTouch® UltraEasy®

Ascensia™ DEX™
Ascensia™ DEX™ 2
Ascensia™ DEXTER-z° ||
Glucometer™ DEXTER-Z°
Ascensia™ ESPRIT® 2
Glucometer™ ESPRIT®
Glucometer™ ESPRIT® 2
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Abbott:

CareLink® USB

Kabel za podatkovnu komunikaciju

. FreeStyle®

. FreeStyle® Lite®

. FreeStyle® Freedom®

. FreeStyle® Freedom Lite®
. Precision Xtra®

. TheraSense FreeStyle®

. FreeStyle® Flash®

. FreeStyle® Papillon™ mini
. FreeStyle® Mini®

. Optium Xceed™

. Precision Xceed™

Koristi se s pumpom za inzulin MiniMed Paradigm i
monitorom Guardian REAL-Time.

Koristi se s pumpom MiniMed Paradigm i monitorom
Guardian REAL-Time. (Pojedinosti o potrebnom
hardveru potraZite u korisnickom priru¢niku za
ComlLink.)

Koristi se s mjerac¢ima glukoze u krvi drugih
proizvodaca. Svaki proizvoda¢ mjeraca isporucuje
kabel za podatkovnu komunikaciju.

Napomena: ako proizvoda¢ mjeraca za prijenos
podataka isporucuje USB kabel umjesto serijskog
kabela, morate instalirati upravljacki program tog
proizvodaca.

Uz to provjerite je li upravljacki program za USB kabel
proizvodaca mjeraca kompatibilan s vasim
operacijskim sustavom. Neki upravljacki programi za
USB kabele mozda nisu dostupni za 64-bitne
operacijske sustave.

Ekvivalentni uredaji

Prilikom dodavanja uredaja u sustav odabirete marku i model s popisa. Ako marka i model

uredaja nisu na popisu, u sljedecoj tablici potrazite ekvivalentan uredaj koji mozete

upotrijebiti.
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. Bayerov Ascensia™ DEX™ 2

. Bayerov Ascensia™ DEXTER-Z™ Il
. Bayerov Glucometer™ DEXTER-Z™
. Bayerov Ascensia™ ESPRIT® 2

. Bayerov Glucometer™ ESPRIT®

Bayerov Ascensia™ DEX™

. Bayerov Glucometer™ ESPRIT® 2

Bayerov Glucometer™ ELITE™ XL Bayerov Ascensia™ ELITE™
Precision Xceed™ Optium Xceed™
Narucivanje

Obratite se lokalnom predstavniku u svojoj drzavi da biste narucili proizvode Medtronic Diabetes.
Informacije o medunarodnim kontaktima mozete pronadi putem sljede¢eg URL-a:

http://www.medtronicdiabetes.com/help/contact/locations.html

NAPOMENA: mjeraci se mogu naruditi od tvrtki koje ih proizvode.

Upute za upotrebu korisnickog priru¢nika

NAPOMENA: korisni¢ki priruc¢nik prikazuje uzorke softverskih zaslona. Zasloni stvarnog
softvera mogu se donekle razlikovati.

U rje¢niku potrazite definicije pojmova i funkcija. Konvencije koristene u ovom priru¢niku
definirane su u sljedecoj tablici.

I Kliknite lijevom tipkom misa iznad objekta na zaslonu
Kliknite . )
da biste ga odabrali.

Dvaput kliknite lijevom tipkom misa iznad objekta na

Lhehdll s zaslonu da biste ga otvorili.

Kliknite desnom tipkom misa iznad objekta na zaslonu

Kliknite desnom tipkom misa da biste prikazali drugi prozor ili izbornik.

Koristi se za gumb, naziv zaslona, naziv polja ili
Podebljani tekst mogucnost na izborniku. Na primjer: Patient > New
Patient (Bolesnik, Novi bolesnik).

NAPOMENA: Pruza dodatne informacije o postupku ili koraku.

Upozorava na opasnost koja, ako se ne izbjegne, moze
OPREZ: uzrokovati manje ili umjereno ostecenje softverskog
programa ili opreme.

Upozorava na potencijalnu opasnost koja, ako se ne
izbjegne, moze uzrokovati smrt ili teSku ozljedu. Moze
oznacavati i mogucnost teskih nuspojava i sigurnosnih
rizika.

UPOZORENJE:
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Sigurnost korisnika

Indikacije za upotrebu

Sustav CarelLink Pro koristi se kao alat koji olak3ava Zivot s dijabetesom. Svrha je tog sustava
prikupljanje informacija koje se prenose s inzulinskih pumpi, mjeraca glukoze i sustava za stalno
pracenje glukoze te njihovo pretvaranje u izvjeS¢a softvera CarelLink Pro. Izvje$c¢a sadrze
informacije koje se mogu koristiti za prepoznavanje trendova i pra¢enje dnevnih aktivnosti - kao
$to su unos ugljikohidrata, vremena obroka, davanje inzulina i vrijednosti glukoze.

Upozorenja

«  Sustav trebaju koristiti zdravstveni djelatnici s iskustvom u kontroli dijabetesa.

+  Rezultati sustava nisu pouzdan temelj za davanje zdravstvenih savjeta te ih ne bi trebalo tako
koristiti.

«  Ovaj proizvod treba koristiti isklju¢ivo s podrzanim uredajima navedenima u ovom
dokumentu (pogledajte PodrZani uredaji na stranici 2).

«  Bolesnicima treba preporuciti da prate svoju razinu glukoze u krvi barem 4 do 6 puta
dnevno.

«  Bolesnike treba upozoriti da ne mijenjaju svoju terapiju bez savjetovanja sa zdravstvenim
djelatnikom.

«  Bolesnike treba upozoriti da odluke o lijecenju trebaju donositi na temelju smjernica koje su
dobili od zdravstvenog djelatnika i rezultata mjeraca glukoze u krvi, a ne rezultata senzora

glukoze.
Kontraindikacije

Ovaj softver ne treba koristiti s uredajima koji nisu navedeni u odjeljku Podrzani uredaji na
stranici 2. Proizvod, uz to, ne treba koristiti za lijeCenje drugih zdravstvenih poremecaja osim
dijabetesa.

Ako je na vasem racunalu trenutno pokrenut neki od sljede¢ih programa, zatvorite ga prije

otvaranja ovog softvera:
«  Softver CGMS® System Solutions™ (7310)
.« Softver za pumpe i mjerace Solutions’ (7311)

«  Softver Guardian® Solutions® (7315)
«  ParadigmPAL™ (7330)
.  Softver CareLink® Personal (7333)

. Softver Solutions’ za CGMS’iPro (7319)
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Uvod u rad

Ovo vas poglavlje vodi kroz pokretanje softvera CarelLink Pro, otvaranje i zatvaranje zapisa o
bolesniku te postavljanje preferenci koje se primjenjuju na sve bolesnike u sustavu.

Prije pocetka

Ako prvi put koristite CareLink Pro, morate provijeriti jeste li postavili General preferences (Opce
preference) (pogledajte odjeljak Opce preference na stranici 12). Te preference odreduju kako se
odredene stavke prikazuju u softveru i izvjes¢ima te kako zelite da sustav komunicira s

internetom.

Preference moZete postaviti u bilo kojem trenutku. Ostale preference mozete postaviti i kasnije,
kada se bolje upoznate sa softverom CareLink Pro.

Primarni zadaci sustava

U sljedecoj su tablici prikazani glavni zadaci Cije se izvrSavanje preporucuje pri prvom postavljanju
i koriStenju programa CareLink Pro. Navodi se i u kojem se dijelu korisni¢kog priru¢nika opisuje
koji zadatak.

Upoznajte se s korisni¢kim suceljem programa

CareLink Pro. Kretanje po sustavu na stranici 8

Definirajte globalne sistemske moguénosti koje ce

vaa ambulanta Koristiti. Postavljanje preferenci sustava na stranici 11

Stvorite profile za svakog bolesnika. Dodavanje novih profila na stranici 20
Povezite se s racunima bolesnika u sustavu CareLink Povezivanje sa sustavom CareLink Personal na
Personal. stranici 21

Dodajte pumpu i mjerace bolesnika u njegov profil. Dodavanje uredaja na stranici 28

Citajte podatke s pumpe i mjeraca bolesnika. Citanje podataka iz uredaja na stranici 34
Postavite i generirajte izvje$¢a za svakog bolesnika. Stvaranje izvje$¢a na stranici 37

CareLink Pro Korisnicki prirucnik ~ Uvodurad 7



Redovito stvarajte sigurnosne kopije baze podataka
programa CareLink Pro.

Stvaranje sigurnosne kopije baze podataka na
stranici 47

Azurirajte softver CarelLink Pro.

Primjena azuriranja softvera na stranici 46

Kretanje po sustavu

Prije pocetka rada s programom CarelLink Pro trebali biste se upoznati s korisni¢kim suceljem.
Korisnicko se sucelje sastoji od izbornika, alatne trake, navigacijske trake, radnih prostora i prozora

Guide Me (Vodi me).

Otvaranje programa CareLink Pro

1 Dva puta kliknite ikonu CareLink Pro E! na radnoj povrsini racunala ili odaberite Medtronic

L4

CarelLink Pro s popisa Programs (Programi) na izborniku Start u operacijskom sustavu

Windows.

Ako vasa ustanova zahtijeva unos lozinke, prikazuje se zaslon za prijavu.

a. Unesite svoju lozinku u polje Password (Lozinka).

NAPOMENA: trazenje lozinke neobavezna je znacajka koja se postavija tijekom

postupka instalacije.

b. Kliknite LOGIN (Prijava).

Prikazat ¢e se pocetni zaslon.

2 Da biste stvorili zapis 0 novom bolesniku, kliknite New Patient (Novi bolesnik). Da biste

otvorili zapis o bolesniku s popisa bolesnika u sustavu, kliknite Open Patient (Otvori

bolesnika).

Radni prostori

Ako je zapis bolesnika otvoren, mozete kliknuti jedan od gumba na navigacijskoj traci da bi se

prikazao odgovarajuci radni prostor. Te radne prostore koristite za unos ili odabir podataka radi

obavljanja odredenih zadataka za tog bolesnika u softveru CareLink Pro.

Profile (Profil): omogucuje odrzavanje pohranjenih
podataka o bolesniku, kao $to su ime i datum rodenja.
Taj vam radni prostor ujedno omogucuje povezivanje
s bolesnikovim ra¢unom u sustavu CareLink Personal.

Devices (Uredaji): omogucuje pohranu podataka
potrebnih za ocitavanje bolesnikovih uredaja.

[w] (&) [=]

Reports (Izvjesc¢a): omogucuje odabir parametara i
izvjeS¢a koji ¢e se generirati za bolesnika.
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Dok ne dodate i ne spremite profil za nekog bolesnika, za njega je dostupan samo radni prostor
Profile (Profil). Dok za nekog bolesnika ne dodate uredaje, za njega su dostupni samo radni
prostori Profile (Profil) i Devices (Uredaji).

Alatna traka

Alatna traka softvera CareLink Pro omogucuje brz pristup cesto koristenim znacajkama. Alatna

traka sadrzi sljede¢e gumbe:

Otvara radni prostor Profile (Profil)
Q Add Patient (Dodavanje bolesnika) da biste u sustav mogli dodati
e zapis o novom bolesniku.

Otvara tablicu Patient Lookup
(Trazenje bolesnika) u kojoj mozete
izabrati zapis postojec¢eg bolesnika
koji zelite pogledati.

q Open Patient (Otvaranje bolesnika)

Prikazuje ili sakriva prozor Guide
I‘ Guide Me (Vodi me) Me (Vodi me). Kliknite da biste
— vidjeli kontekstne savjete sustava.

Kartice bolesnika

Kada otvorite zapis bolesnika, uz alatnu se traku prikazuje kartica s imenom bolesnika. Ako je
kartica aktivna, to znaci da su zapis o bolesniku i radni prostor aktivni te da za tog bolesnika

mozete obavljati zadatke u programu CareLink Pro.

=& Medtronic Carelink® Pro

Fi|E__"."iE!.-\.' Tnpls Languags Help | % q ?

Mew Patient []

Da biste aktivirali zapis bolesnika i poceli raditi s njim, kliknite na karticu tog bolesnika. Da biste
zatvorili zapis bolesnika, kliknite gumb Close (Zatvori) E na kartici.

Znacajka Guide Me (Vodi me)

Znacajka Guide Me (Vodi me) dostupna je svugdje u programu CareLink Pro. Ona otvara prozor s
kontekstnim savjetima o radnjama koje moZete poduzeti iz dijela sustava koji je trenutno aktivan.
Prozori funkcije Guide Me (Vodi me) mogu sadrzavati i veze >>learn more (saznajte vise). Kada ih
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kliknete, te vas veze vode do relevantnog odjeljka mrezne pomoci u kojem mozete pronaci
dodatne informacije. Znacajka Guide Me (Vodi me) prema zadanim je postavkama omogucena.
No mozete je iskljuciti u bilo kojem trenutku.

|

Start up window

IF you choose ko add & new patient, a

blank Profie warkspace is dsplayed. IF
you choose ko open an existing patisnt
rezed, the Cpen Fabent wandow is

displayzd,

#¥ learn mars

What next? =

T wou are adding 4 new patient, woo il
complece their prafile.

¥ learn nnre

If you @e Opening an exctmg patiens,
wau can: ot

Ukljucivanje i iskljucivanje znacajke Guide me (Vodi me)
Da biste ukljucili ili iskljucili zna¢ajku Guide Me (Vodi me), uinite nesto od sljedeceg:
+  Kliknite gumb Guide Me (Vodi me). 2

«  Odaberite Help (Pomo¢) > Guide Me (Vodi me).

Otvaranje zapisa o bolesniku

Istodobno moze biti otvoreno najvise Sest bolesnickih zapisa. Ako jo$ niste stvorili profile
bolesnika, pogledajte odjeljak Dodavanje novih profila na stranici 20.

1 Odaberite File > New Patient (Datoteka, Novi bolesnik) ili kliknite gumb Open Patient

(Otvaranje bolesnika). & Prikazuje se popis bolesnika sli¢an sljede¢em.

“w Upen Patient

Find a Pakient || cLeam LS
[ Date of

| Firsk Hame Last Name Birth Patient 1D

SAMPLE PATENT A 0{1475 ]

Sanpk Patizrk2 AL 100001

Sanpk Patierkd 19T 100002

@ oFEN | [ CancEL
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NAPOMENA: ako primite poruku s napomenom da ste otvorili previse zapisa o
bolesniku, kliknite OK (U redu), zatvorite neki zapis i nastavite.

2 Pronadite bolesnika na popisu tako da upisete njegovo ime ili dio imena u polje Find a
Patient (Pronadi bolesnika). Kada je bolesnik istaknut na popisu, kliknite OPEN (Otvori),
dvokliknite popis ili pritisnite tipku ENTER. Po popisu se mozete kretati i pomocu strelica za
gore i dolje na tipkovnici.

Za bolesnika se prikazuje radni prostor Devices (Uredaji) (ako uredaji jo$ nisu dodani) ili radni
prostor Reports (Izvjesca).

3 Da biste vidjeli radni prostor Profile (Profil) za bolesnika, kliknite gumb Profile (Profil) @

SR |

na navigacijskoj traci.

Zatvaranje zapisa o bolesniku

1 Provjerite je li zapis bolesnika koji Zelite zatvoriti aktivan (kartica je istaknuta).

2 Udinite nesto od navedenog:
a. Odaberite File > Close Patient (Datoteka, Zatvori bolesnika).
b. Kliknite gumb Close (Zatvori) 4 na kartici bolesnika.
c. Pritisnite Ctrl+F4.

Postavljanje preferenci sustava

Te se preference primjenjuju na sve bolesnike u sustavu. Informacije o preferencama koje utjecu
samo na pojedine bolesnike potrazite u odjeljku Provjera postavki izvies¢a na stranici 40.

Preference su prikazane u sljede¢im grupama:

«  General (Opcenito)
- Glucose units (Jedinice glukoze)
- Carbohydrate units (Jedinice ugljikohidrata)
- Communications (Komunikacija)
- Troubleshooting (Otklanjanje poteskoca)

. Patient Profile (Profil bolesnika)

- odabir i rasporedivanje polja podataka u profilima bolesnika

«  Patient Lookup (Trazenje bolesnika)
- modificiranje i promjena redoslijeda polja koja se prikazuju kada odaberete Open Patient
(Otvori bolesnika) da biste prikazali popis bolesnika

+  Report Generation (Stvaranje izvjestaja)
- odabir polja podataka koja zelite da se prikazuju kada odaberete unos u izvjes¢e Daily
Detail (Dnevne pojedinosti) iz podatkovne tablice
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Opce preference
Na kartici General (Opce postavke) odredite kako ¢e se u programu prikazivati odredene vrste
informacija i postavite preference vanjske komunikacije.

1 Ako kartica General (Opce postavke) jos nije aktivna, kliknite je.

2 Odaberite Tools > Options (Alati > Mogucnosti). Prikazuje se sljededi prozor.

o okl conore for oRPLRECATIONE el LNEE Of S aiup s 13 man pa—
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Adhsiirir Crerrlay = e ke by b v e bk Py s

Crangen. sl ke offact 5 raat e yosi baursh Hhe spplestion

1 ek bt ey
| IR 5 snajribsl st fveiy dewsde et ol sl dana b
Mt g

(Brarmsin b reganed ta 1aad s devost)
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3 Kliknite gumb mogucnosti da biste odabrali zeljenu vrijednost.
- Glucose Units (Jedinice glukoze): mmol/L ili mg/dL
- Carbohydrate Units (Jedinice ugljikohidrata): grami ili razmjene

a. Ako ste za Carbohydrate Units (Jedinice ugljikohidrata) odabrali Exchanges (Razmjene),
upisdite odgovarajudi broj u polje grams are equal to 1 Exchange (grama vrijedi kao 1
razmjena).

4 Kliknite da biste potvrdili ili ponistili okvir u odjeljku Chart Options > Overview Report
(Moguc¢nosti grafikona > lIzvjeS¢e o pregledu). Ako je okvir potvrden, aplikacija ¢e crtama
povezati ocitanja glukoze u krvi na grafikonu Meter Glucose Overlay (Slika mjerenja glukoze).
(To je grafikon koji se pojavljuje u izvjes¢u Sensor and Meter Overview Report (Izvjesc¢e o
senzoru i pregledu mjeraca).)

5 Za sljede¢e moguénosti odjeljka Communications (Komunikacije) klikom potvrdite
(omogucite) ili ponistite (onemogucdite) potvrdni okvir:

NAPOMENA: obavezno slijedite smjernice svoje ambulante ili IT odjela za postavijanje
komunikacijskih preferenci.

- Automatically check for software updates (Automatsko trazenje azuriranja
programa): Kada je ta moguénost odabrana, svakom sustavu na kojem je pokrenut
CareLink Pro poslat ¢e se obavijest svaki put kada postane dostupno azuriranje
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programa. Aktivni ¢e korisnik tada imati mogucnost preuzimanja i instalacije aZuriranja.
Da biste to sprijecili i uveli upravljanu distribuciju azuriranja programa, mozete ponistiti
taj potvrdni okvir.

- Synchronize with Medtronic CareLink® Personal (Sinkronizacija s programom
Medtronic CareLink® Personal): Potvrdite taj okvir ako Zelite da sustav automatski
sinkronizira bolesnikove podatke iz programa CareLink Personal pri svakom otvaranju
profila. Ako ponistite taj potvrdni okvir, morat ¢ete ru¢no sinkronizirati podatke iz
programa CareLink Personal za svakog bolesnika.

6 Kliknite da biste potvrdili ili ponistili okvir u odjeljku Troubleshooting (Otklanjanje
poteskoca). Ako je potvrdni okvir odabran, program e spremiti zapis s oCitanjima uredaja
radi otklanjanja poteskoca.

7 Kliknite OK (U redu) da biste spremili opce preference.

Preference profila bolesnika

To je globalna postavka koja odreduje sadrzaj vasih profila. U radnom prostoru Profiles (Profil)

mozete prilagoditi polja da biste ukljucili informacije koje su najvaznije za vasu ustanovu. MozZete
dodavati ili uklanjati polja, stvarati vlastita prilagodena polja i odredivati redoslijed prikazivanja
polja u prozoru.

1 Odaberite Tools > Options (Alati > Moguc¢nosti).

2 Kliknite karticu Patient Profile (Profil bolesnika). Prikazuje se sljedeci prozor.

L Uplians

. General Pyt it Profiie Fabent Losdup  Aegert Geserabion

St and order the daba Fekds thal shoud b2 depleesd 2 pat of Chel paGert profie #2 b mn
Edenkification Detals Fuhil Oiedior

Peaquiied Bogeired | % Fet dame

st BamEe v [iGen des . Lt

Dratw af Birth

[F]Fatiest B o Patient By
[Floate of Birth a- |\ ‘N = ]
[Ceedin +

[ Sl

Comitack Cotars

. [r— —
Phone * D "
N . |l o
] Audebrams ' | st
' O
: o
' O

Dt

Gy
[Itatn
Czm
[ClCaumtrs

Tustoumily +

NAPOMENA: pomocu potvrdnih okvira odaberite polja koja Zelite uvrstiti u profil.
Koristite strelice prema gore i prema dolje da biste poredali polja.

Odabir podatkovnih polja

1 Pomocu potvrdnih okvira dodajte Zeljena polja.
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NAPOMENA: polja First Name (Ime) i Last Name (Prezime) nije moguce ukloniti.

2 Da biste uklonili polje iz profila, ponistite njegov potvrdni okvir.

3 Da biste polje postavili kao obavezno, potvrdite okvir u stupcu Required (Obavezno).
Obavezna se polja moraju ispuniti radi stvaranja profila.

Dodavanje prilagodenog polja

1 Potvrdite okvir s lijeve strane praznog prilagodenog polja.

2 Unesite tekst da biste polju dodijelili naziv (primjerice "Kontakt u hitnom slu¢aju”). Taj ¢e
naziv polja biti prikazan na profilu bolesnika.

3 Da biste polje postavili kao obavezno, potvrdite okvir u stupcu Required (Obavezno).

NAPOMENA: da biste prilagodeno polje uklonili iz profila, ponistite potvrdni okvir
pokraj polja koje Zelite ukloniti.

Promjena redoslijeda podatkovnih polja

Odaberite polje koje zelite premjestiti, a zatim kliknite strelicu prema gore ili dolje f ; da biste
ga premijestili (strelicama prikazanima pri vrhu i pri dnu mozete pomaknuti polje potpuno na vrh
ili na dno popisa).

Zatvaranje preferenci profila bolesnika

Kada popis Field Order (Redoslijed polja) sadrzi sva Zeljena polja poredana ispravnim
redoslijedom, kliknite OK (U redu).

Profili bolesnika sada sadrze polja i redoslijed polja koji ste upravo odabrali.

Preference trazenja bolesnika

Tablica Patient Lookup (Trazenje bolesnika) koristi se za trazenje i otvaranje zapisa o bolesniku.
Tablica sadrzi sve bolesnike u bazi podataka i pruza informacije za identifikaciju iz profila
bolesnika. Mozete prilagoditi informacije iz tablice i redoslijed prikazivanja stupaca. Da biste
prilagodili tablicu Patient Lookup (Trazenje bolesnika), ucinite sljedece:

1 Odaberite Tools > Options (Alati > Mogucnosti).
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2 Kliknite karticu Patient Lookup (TraZenje bolesnika). Prikazuje se sljedeci prozor.
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NAPOMENA: pomocu potvrdnih okvira odaberite polja koja Zelite uvrstiti u tablicu
Patient Lookup (TraZenje bolesnika). Koristite strelice prema gore i dolje da biste
poredali stupce.

Odabir podataka za prikaz

Pomocu potvrdnih okvira odaberite vrstu podataka koju Zelite ili ocistite podatke koje ne Zelite
prikazati u tablici Patient Lookup (Trazenje bolesnika).

Promjena redoslijeda stupaca

Da biste promijenili redoslijed stupaca u tablici Patient Lookup (Trazenje bolesnika), odaberite
stupac koji ¢ete pomaknuti i kliknite strelice prema gore ili dolje : ; (strelicama prikazanima pri
vrhu i pri dnu mozete pomaknuti podatkovni stupac potpuno na vrh ili na dno popisa).
Podatkovni stupac pri vrhu popisa Column Display Order (Redoslijed prikaza stupaca) bit ¢e
prikazan u prvom stupcu tablice Patient Lookup (Trazenje bolesnika). Podatkovni stupac pri dnu
bit ¢e prikazan u zadnjem stupcu tablice.

Zatvaranje preferenci trazenja bolesnika

Kada popis Column Display Order (Redoslijed prikaza stupaca) sadrzi sve Zeljene podatke
ispravnim redoslijedom, kliknite OK (U redu).

Tablica Patient Lookup (Trazenje bolesnika) sada sadrzi podatke i redoslijed stupaca koji ste
upravo odabrali.
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Preference generiranja izvjesca

Data Table (Tablica s podacima) prikazuje se u prozoru Select and Generate Reports (Odabir i
generiranje izvjesca). Ta se tablica koristi tijekom izvjeSc¢ivanja. Ona sadrzi dnevne informacije
iz uredaja vasih bolesnika i, ako je to primjenjivo, njihovih ra¢una u sustavu CareLink Personal.
Prema podacima iz tablice lakse ¢ete odrediti na koje je dane obvezno generiranje izvjesca
Daily Detail report (Dnevne pojedinosti). Oni ¢e vam olaksati i odluc¢ivanje o drugim izvjes¢ima
koja trebate generirati.

Ustanova moze prilagoditi podatke koji ¢e se prikazivati u toj tablici, ukljuCujuci i redoslijed

prikazivanja, ovisno o vaznosti za vasu praksu.

NAPOMENA: da biste vidjeli kako se te preference primjenjuju na tablicu s podacima
tijekom stvaranja izvjesc¢a, pogledajte odjeljak Odabir vrsta izvies¢a i datuma uvrstavanja na
stranici 41.

1 Odaberite Tools > Options (Alati > Mogu¢nosti).

2 Kliknite karticu Report Generation (Generiranje izvjeSca). Prikazuje se sljedeci prozor.
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Odabir podataka za prikaz

Pomocu potvrdnih okvira odaberite vrstu podataka koje Zelite ili ocistite podatke koje ne zelite

prikazati u podatkovnoj tablici.

U tablicu Data Table (Tablica s podacima) mozete uvrstiti sljedece informacije.
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Ne of Meter Readings (Broj ocitanja na mjeracima)

Broj ocitanja za odredeni datum zabiljezenih aktivnim
uredajima.

Sensor Duration (Trajanje senzora)

Highest Reading (Najvise ocitanje)

Avg AUC Below Target (Prosje¢no podrugje ispod
krivulje za ciljnu razinu bolesnika)

Total Carbs (Ukupni ugljikohidrati)

N2 of Rewinds (Broj okretanja)

Vrijeme unutar odredenog datuma za koje su
zabiljezeni podaci senzora. Vrijednosti su -- (nista), 0:05
- 24:00.

Najvisa ocitana vrijednost glukoze (sa senzora ili
mjeraca) za odredeni datum.

Prosje¢no podrucje ispod krivulje za ciljnu razinu
bolesnika.

Zbroj svih ugljikohidrata (zaokruzen na najblizi gram ili
razmjenu od 0,1, ovisno o mjernoj jedinici) koja je
zabiljezena tijekom dana pomocu Bolus Wizard
dogadaja ili markera ugljikohidrata na pumpi ili
Guardian monitoru.

Broj okretanja za odredeni datum.

Prime (or Fill) Volume (U) (Koli¢ina pocetnih ciklusa ili
punjenja)

Total Basal (U) (Ukupni bazalni)

Basal % (Postotak bazalnog inzulina)

Ne of Boluses (Broj bolusa)

Bolus Wizard Overrides (Preskakanje Bolus Wizard
dogadaja)

Ukupna koli¢ina inzulina koja se koristi za pocetni
ciklus (ili punjenje) na odredeni datum.

Ukupna koli¢ina bazalnog inzulina ubrizganog tijekom
odredenog datuma (ukupni ubrizgani inzulin minus
zbroj svih ubrizganih bolusa).

Pokazuje omjer (u cjelobrojnim postotnim
vrijednostima) bazalnog inzulina u odnosu na ukupni
inzulin.

Broj bolusa zabiljezenih na odredeni datum.

Broj Bolus Wizard dogadaja kod kojih se ubrizgani
inzulin razlikuje od preporucene koli¢ine.
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Broj Bolus Wizard dogadaja s koli¢inama korekcije

Ne of Correction Boluses (Broj korektivnih bolusa) veéim od nule zabiljezenih na odredeni datum

Broj bolusa zabiljeZenih tijekom odredenog datuma

Ne of Manual Boluses (Broj ru¢nih bolusa) koji nisu bili Bolus Wizard dogadaji.

Promjena redoslijeda stupaca
Da biste promijenili redoslijed stupaca u tablici Data Table (Tablica s podacima), odaberite stupac
koji ¢ete pomaknuti i kliknite strelice gore ili dolje : ; (strelicama prikazanima pri vrhu i pri dnu

mozete pomaknuti podatkovni stupac potpuno na vrh ili na dno popisa).

NAPOMENA: podatkovni stupac na vrhu popisa Column Order (Redoslijed stupaca) bit ce
prikazan u prvom stupcu podatkovne tablice. Stavke pri dnu prikazat ce se u zadnjem
stupcu podatkovne tablice.

Dovrsenje preferenci generiranja izvjeS¢a

Kada popis Column Order (Redoslijed stupaca) sadrzi sve zeljene podatke u odgovarajuc¢em
redoslijedu, kliknite OK (U redu).

Podatkovna tablica sada sadrzi podatke i redoslijed stupaca koji ste upravo odabrali.
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Radni prostor Profile (Profil)

Profil je neSto poput pocetne stranice medicinskog kartona. On sadrzi podatke o bolesniku, kao
$to su ime i datum rodenja. Profil je potreban za prikupljanje podataka iz uredaja i koristenje u
izvjeS¢ima o terapiji.
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Devices Patient D
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l SEND E-MAIL INVTTATDON TO PATIENT

Radni prostor Profile (Profil) ujedno omogucuje povezivanje s bolesnikovim ra¢unom u programu
CareLink Personal. Nakon uspostave veze u bilo kojem trenutku mozete dohvatiti podatke o
bolesniku pohranjene u sustavu CareLink Personal, a bolesnik ne mora biti prisutan.

Prije pocetka
Preporuc¢ujemo vam da prilagodite profile bolesnika tako da sadrze samo onu vrstu podataka

koju Zelite prikupiti. Dodatne informacije potrazite u odjeljku Preference profila bolesnika na
stranici 13.
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Potrebno je i korisni¢ko ime i lozinka da biste postavili vezu s bolesnikovim ra¢unom u sustavu

CareLink Personal. Bolesnik mora biti prisutan da bi vam pruzio te podatke.

Dodavanje novih profila

Svaki put kada dodate bolesnika u sustav CarelLink Pro, najprije morate ispuniti njegov profil.

1

Odaberite File > New Patient (Datoteka, Novi bolesnik) ili kliknite gumb Add Patient (Dodaj
bolesnika). g

Prikazuje se radni prostor Profile (Profil).

NAPOMENA: da biste dodali ili promijenili polja u profilu bolesnika, kliknite Customize
fields (Prilagodi polja). Pogledajte Preference profila bolesnika na stranici 13.

Ispunite polja u odjeljku Patient Profile (Profil bolesnika).
Kliknite SAVE (Spremi).

Profil novog bolesnika dodaje se u bazu podataka sustava CareLink Pro. Prikazuje se poruka
kojom se potvrduje da je profil spremljen.

Ispunjavanje obaveznih polja

1

Ako obavezno polje nije ispunjeno kada spremate profil bolesnika, pokraj tog polja prikazuje
se poruka. Spremanje profila ne¢e vam biti dopusteno sve dok ne izvrsite unos u polje.

Ispunite polje.
Kliknite SAVE (Spremi).

Kada se pojavi poruka za potvrdu, kliknite OK (U redu).

Uredivanje profila bolesnika

H W N

Provijerite je li radni prostor Profile (Profil) bolesnika otvoren.
Kliknite EDIT (Uredivanje).

Uredite podatke u odjeljku Patient Profile (Profil bolesnika).
Kliknite SAVE (Spremi).

Prikazuje se poruka kojom se potvrduje da je profil spremljen.

Brisanje podataka o bolesniku iz sustava

Provjerite je li radni prostor Profile (Profil) bolesnika otvoren.

Provijerite je li rije¢ o bolesniku kojeg zZelite izbrisati. Brisanjem profila bolesnika ujedno ¢ete
ukloniti sve njegove podatke iz baze podataka sustava CareLink Pro. Taj postupak nije
moguce ponistiti.
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3 Iznad odjeljka za sinkronizaciju profila kliknite >> delete patient record (izbrisi zapis o
bolesniku).

Prikazuje se poruka s upozorenjem da ¢e se brisanjem zapisa izbrisati svi podaci o
bolesniku.

4 Da biste izbrisali zapis o bolesniku, kliknite Yes (Da).

Povezivanje sa sustavom CareLink Personal

Ako je bolesnik suglasan, mozete postaviti vezu s njegovim racunom u sustavu CarelLink Personal.
Taj web-alat bolesnicima omogucuje prijenos i pohranu podataka primljenih iz uredaja te
sastavljanje razlicitih izvjes¢a o terapiji.

Kada se povezete s bolesnikovim racunom u sustavu CareLink Personal, mozete dohvacati
podatke iz uredaja koji su ondje pohranjeni. To je idealno za stvaranje izvjeS¢a sustava CarelLink
Pro o terapiji izmedu posjeta ordinaciji. Uz to se i smanjuje potreba za citanjem bolesnikova
uredaja u ordinaciji.

Ako bolesnik jo§ nema racun u sustavu CarelLink Personal, mozete mu poslati poruku e-poste i
pozvati ga da otvori racun.

Povezivanje s postoje¢im racunom

NAPOMENA: bolesnik mora biti prisutan radi dovrsenja ovih koraka.

1 Morate biti povezani s internetom.
Otvorite radni prostor Profile (Profil) za bolesnika.

Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

H W N

Kliknite LINK TO EXISTING ACCOUNT (Povezivanje s postoje¢im racunom).
Prikazat ¢e se zaslon za prijavu u sustav CareLink Personal.

5 Bolesnik sada mora:
a. upisati svoje korisni¢ko ime i lozinku

b. kliknuti Sign In (Prijava)

Prikazuje se stranica Grant Access (Dopustanje pristupa) na temelju postavki prijave
bolesnika za jezik i regiju.
6 Bolesnik sada mora:
a. procitati odjeljak Terms of Use (Uvjeti upotrebe)
b. klikom potvrditi okvir pored teksta | agree to the Terms of Use above... (Slazem se s
gore navedenim uvjetima upotrebe)
c. kliknuti Grant Access (Dopusti pristup)
d. obavijestiti vas kada se pojavi stranica Thank You (Zahvala).

7 Po potrebi ispisite uvjete upotrebe za bolesnika klikom na gumb Print (Ispis). Sada ste

povezani s bolesnikovim raCunom u sustavu Carelink Personal.
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Slanje pozivnice e-poStom

Da biste bolesniku poslali e-postu s pozivnicom za otvaranje ra¢una za CarelLink Personal,
ucinite sljedece:

1 Otvorite radni prostor Profile (Profil) za bolesnika.

2 Ispunite sva obavezna polja u odjeljku Patient Profile (Profil bolesnika).

3 Kliknite SEND E-MAIL INVITATION TO PATIENT (Pos3alji bolesniku pozivnicu e-postom).

S8 E-Manl Imwitation

Patient Mame  [SaE Parin |
E-Mail Addeess |
Lengquage Ercleh -
Bubjuct [iegaer i ver Pldirs, Casirk Prrse |

MacEage | e SR FRTIENT ¥

W

(=0 ] [cancet ]

4  Provjerite jesu li polja Patient Name (Ime bolesnika), Email Addresss (Adresa e-poste) i
Language (Jezik) ispravno ispunjena.

5 Kliknite SEND (Posalji).
U podrugju sa statusom profila bolesnika potvrduje se slanje e-poste.
Primanje podataka iz povezanog ra¢una

Ako ste povezani s bolesnikovim ra¢unom u sustavu CarelLink Personal, svi novi podaci iz

raCuna automatski se 3alju svaki put kada otvorite njegov profil u programu CareLink Pro.

NAPOMENA: da biste bili sigurni da ce se to dogoditi, idite na Tools > Options > General
(Alati, Mogucnosti, Opcenito) i provjerite je li potvrden okvir "Synchronize with CareLink
Personal" (Sinkronizacija sa softverom CareLink Personal).

Da biste u bilo kojem trenutku nakon otvaranja bolesnikova profila preuzeli njegove podatke
iz sustava CareLink Personal, slijedite ove korake:

1 Provjerite je li otvoren radni prostor Profile za bolesnika te jeste li povezani s internetom.
2 Odaberite Tools > Synchronize Patient Data (Alati, Sinkronizacija podataka o bolesniku).

lkona za sinkronizaciju ¢ na kartici bolesnika pocinje se okretati. Kada se ikona zaustavi,

postupak je dovrien.

NAPOMENA: ako bolesnik vise ne Zeli dijeliti svoje podatke iz sustava CareLink
Personal, prikazuje se odgovarajuca poruka.
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3 Svi dodatni podaci dohvacdeni iz sustava CarelLink Personal bit ¢e vidljivi u izvjeS¢ima o
bolesniku.

Prekid veze bolesnikova racuna u sustavu CareLink Personal sa softverom
CareLink Pro

Mozete prekinuti vezu bolesnikova ra¢una u sustavu Carelink Personal sa softverom CareLink
Pro. Ta je mogucnost dostupna tek nakon uspostavljanja veze. Nakon prekida veze CareLink
Pro vise ne moze dohvacati bolesnikove podatke iz sustava CareLink Personal. To ne utjeCe na
osobnu upotrebu racuna u sustavu CareLink Personal od strane bolesnika.

1 Otvorite zapis o bolesniku i pristupite radnom prostoru Profile (Profil).
2 Kliknite UNLINK ACCOUNT (Prekini vezu s racunom).

3 Kliknite Yes (Da) u poruci za potvrdu. Osobni profil bolesnika vise nije povezan sa softverom
Carelink Pro.

Status se mijenja u Not linked (Nije povezan), a prikazuju se gumbi LINK TO EXISTING
ACCOUNT (Povezivanje s postojec¢im racunom) i SEND E-MAIL INVITATION TO PATIENT
(Posalji bolesniku pozivnicu e-postom).
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Postavljanje hardvera

Da biste podatke ocitavali izravno s uredaja, morate imati bolesnikov uredaj kod sebe, kao i

kabele ili druge komunikacijske uredaje potrebne za prijenos podataka na racunalo.

Ako je bolesnik podatke s uredaja prenio na svoj racun u sustavu CarelLink Personal, podatke
umjesto toga mozete dohvatiti povezivanjem s njegovim rac¢unom. Informacije o povezivanju s
bolesnikovim ra¢unom u sustavu CarelLink Personal potrazite u odjeljku Povezivanje sa sustavom
Carelink Personal na stranici 21.

Povezivanje uredaja

Proucite pregledni dijagram da biste dobili ideju o tome kako postaviti uredaje radi komunikacije

s racunalom. Dijagrami koji slijede ilustriraju posebne aspekte komunikacije uredaja.

Dodatne pojedinosti mozete pronaci u uputama koje CareLink Pro prikazuje dok ocitavate

uredaje.
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Pregled postavljanja hardvera

Ovaj primjer prikazuje kako se CareLink USB koristi za komunikaciju izmedu pumpe i racunala:
Popis podrzanih komunikacijskih uredaja potrazite u odjeljku PodrZani uredaji na stranici 2.

Primjeri povezivanja serijskog i USB kabela:
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Dodatni ComLink za koristenje s pumpom serije Paradigm:

Dodatna stanica Com-Station za koristenje s pumpom Medtronic MiniMed 508:
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Radni prostor Devices (Uredaji)

Informacije koje ¢e vam trebati za ocitavanje podataka s bolesnikova uredaja, primjerice
proizvodac, model i serijski broj, pohranjene su u radnom prostoru Devices (Uredaji). Zato ih ne
morate navoditi prilikom svakog ¢itanja podataka s uredaja.
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Uredaji u radnom prostoru Devices (Uredaji) pohranjeni su na jednom od dva popisa: Active
Devices (Aktivni uredaji) ili Inactive Devices (Neaktivni uredaji). Kada dodate uredaj, on se
automatski smjesta na popis Active Devices (Aktivni uredaji). MoZete citati samo podatke s
uredaja prikazanih na popisu Active Devices (Aktivni uredaji). Na tom ¢e se popisu vjerojatno
nalaziti uredaji koje bolesnik trenutno koristi.

Ostali uredaji koji pripadaju bolesniku, no trenutno se ne koriste, mogu se pohraniti na popisu
Inactive Devices (Neaktivni uredaji). Na taj nac¢in podaci ostaju zapisani. Te je uredaje mogudce
uciniti aktivnima u bilo kojem trenutku.
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Prije pocetka

Da biste mogli otvoriti radni prostor Devices (Uredaji) za nekog bolesnika, njegov profil mora biti

spremljen u sustavu. Pogledajte Dodavanje novih profila na stranici 20.

Da biste dodali uredaj ili procitali podatke izravno s njega, uredaj mora uspostaviti komunikaciju s
racunalom. Pogledajte Povezivanje uredaja na stranici 24 da biste doznali kako postaviti uredaje

radi komunikacije s ra¢unalom.

Dodavanje uredaja

Podatke s bolesnikova ra¢una u sustavu CarelLink Personal mozete dohvatiti i ako uredaj jos nije
dodan u sustav. Ti se uredaji automatski dodaju nakon sinkronizacije podataka izmedu sustava

CareLink Personal i CareLink Pro.

NAPOMENA: moze postojati samo jedna aktivna pumpa za jednog bolesnika. Dodavanjem
nove pumpe postojecu cete pomaknuti na popis neaktivnih.

Dodavanje pumpe Medtronic ili monitora Guardian

1 Provjerite je li uredaj koji dodajete postavljen za komunikaciju s racunalom (Povezivanje

uredaja na stranici 24 sadrzi opis koraka povezivanja).

2 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (Trazenje

bolesnika).

3 Kliknite Devices (Uredaji) ﬁi da biste pristupili radnom prostoru Devices (Uredaji) za

bolesnika.
4 Kliknite ADD DEVICE (Dodaj uredaj).

5 Odaberite Medtronic Pump/Guardian. Prikazuje se carobnjak Add Medtronic Pump/

Guardian (Dodavanje pumpe Medtronic/Guardian).

=8 Add Medironic Pump J Guardian

Fodel Selection Step 1 z 1 i

Selact the Medbronic devios you veould B to add bo e systen.
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(7} Mirdted Parndgm Seres pumg
HirdMad! Guardian REAL-Time mandon
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NAPOMENA: model pumpe naveden je na straZnjoj strani pumpe ili na zaslonu statusa

pumpe.
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6 Odaberite gumb mogucnosti da biste odredili koji uredaj dodajete.
Ako ste odabrali moguc¢nost MiniMed 508 pump, idite na 9. korak.

7 Kliknite NEXT (Dalje). Prikazuje se stranica Serial Number (Serijski broj).

w Add Medtronic Famp f Guardian

Gerial Mumber step 1 =@ q |

Erfer the device's i cheracter ssiel number, Found on the beck of the deuice ar on Bhe skatus
ccFoan. Sariad numberc may contain lotters ac wal ac numbere.

¥ be3n more

Device Serial Murmber:

REF MMTSE5HAER
LR

hEx

NAPOMENA: ako ne unesete ispravan serijski broj, prikazuje se poruka o pogresci.
Pogledajte primjere na ovoj stranici i provjerite unosite li ispravne znakove sa straznje
strane pumpe. Prema potrebi ponovno unesite sest znakova.

8 Primjeri na ovoj stranici olaksat ¢e vam pronalaZenje Sesteroznamenkastog broja na uredaju
koji dodajete. (Ako vam je potrebna dodatna pomo¢ da ga pronadete, kliknite >> learn more
(doznajte vise)). Upisite Sest znakova u polje Device Serial Number (Serijski broj uredaja).

9 Kliknite NEXT (Dalje). Prikazuje se stranica Communication Options (Moguénosti
komunikacije) koja izgleda poput sljedece.

& Add Medtronic Pump § Guardian

Commisnication Dptions Step ] T 3 ']
Thaonss which port your confedthity device = sttached Eo.
5 laarm mory
Choose Port:
é E sako Detect (or LISE) w
Bare | [ mecr | [ camc |

10 Kliknite padajudi izbornik Choose Port (Odabir priklju¢ka) i odaberite priklju¢ak s kojim se
ComlLink, Paradigm Link’, CareLink USB ili Com-Station povezuje na vasem rac¢unalu. Ako
niste sigurni koji priklju¢ak odabrati, odaberite Auto Detect (or USB) (Automatsko otkrivanje
(ili USB)).
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11

12

13

Kliknite NEXT (Dalje). Prikazuje se stranica Test Connection (Testiranje veze) koja izgleda

poput sljedece.

& Rdd Medironic Pump § Guardian rf

Test Conme b Slei i 2 1 L]

Test the corraciaon n onder 1o complabe the s device protesi.
I using & Parsdiom Link. device, verfy B s OFF before continung,

¥ lem o

Device:
Par achrs purt | Guardian REAL-Time m
Serial Mumber:
125 &3
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el |

[ eace | [ mest | [cawm |

Slijedite upute uredaja i kliknite TEST (Testiraj).

Prikazuje se poruka o tome je li povezivanje bilo uspjesno. Ako jest, prijedite na sljededi
korak.

NAPOMENA: tim se testom ne ¢itaju podaci iz pumpe, vec se provjerava ispravnost
komunikacije izmedu pumpe i racunala.

Ako komunikacija nije ispravna, provjerite je li hardver izmedu uredaja i racunala ispravno
povezan. Takoder kliknite BACK (Natrag) na stranicama carobnjaka da biste provjerili jeste li

unijeli ispravne podatke s uredaja.
Kliknite DONE (Dovrseno).

Mjerac se dodaje na bolesnikov popis Active Devices (Aktivni uredaiji).

Dodavanje mjeraca

1

Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (Trazenje

bolesnika).

Provjerite komunicira li mjerac koji dodajete s racunalom (Povezivanje uredaja na stranici 24

sadrzi opis koraka povezivanja).

Kliknite Devices (Uredaji) da biste pristupili radnom prostoru Devices (Uredaji) za

bolesnika.

Kliknite gumb ADD DEVICE (Dodavanje uredaja).
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5 Odaberite Blood Glucose Meter (Mjera¢ glukoze u krvi). Prikazuje se ¢arobnjak Add Blood
Glucose Meter (Dodavanje mjeraca glukoze u krvi).

& Add Blood Glucose Meter

Meter Brand Sep 1 2 3 |

Sapct the beand of maber ye would B 1o a4 £othe system

Py -
(% Medtrenic Link Meters
() Aeeu-Chek (Roche)
O Ascension (Bayer)
180
(iMedisense® | TheraSense® {Abbott)
CrneTouch (LifeScan)

wir | [ ]  [cwen ]

6 Kliknite gumb moguc¢nosti da biste odabrali ispravnu marku mjeraca.

7 Kliknite NEXT (Dalje). Prikazuje se stranica Meter Model (Model mjeraca) (ova se stranica
razlikuje ovisno o proizvodacu mjeraca).

& Add Blood Glucose Meler

S

Meter Model Step 1 z 3 q

Choose the Medbronic Link meter you would Boe bo add ko the sysbem,

BE b A
] n-mm

Paradl-wrl Link#& tl:hTm Link: Lt al bk ™

[oacx | [ x| [ canca |

8 Kliknite model mjeraca koji dodajete da biste ga odabrali.

9 Kliknite NEXT (Dalje). Prikazuje se stranica Communication Options (Moguénosti
komunikacije).

S hdd Blood Glucose Meter ril

Coapamiraalion Options Step | z 3 4

Choose wihich poet the meter & connectsd bo.

Fr i o

Choose Foriz

[oacx | [ o | [ canca |
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NAPOMENA: za odabir su dostupne samo valjane mogucnosti za mjerac koji dodajete.

Kliknite padajudi izbornik Choose Port (Odabir priklju¢ka) i odaberite priklju¢ak s kojim se
ComlLink, Paradigm Link ili CareLink USB povezuje na vasem rac¢unalu. Ako niste sigurni koji
priklju¢ak odabrati, odaberite Auto Detect (or USB) (Automatsko otkrivanje (ili USB)).

Kliknite NEXT (Dalje). Prikazuje se stranica Test Connection (Testiranje veze).

& Add Blood Glucose Molor r;l

Tesk Conneclion L% 1 | 2 3 4

Tt Hhe connection in order bo complets the sdd devics poosss,
Before resdreg your meter, verly your meter is ON.

BE W T R

[ ]
By CONTOUEL Link .
Comemmnscation: :
o Detect |‘E

E |

[ mack || west | | camcel

Slijedite upute dane za mjera¢ i kliknite TEST (Testiraj).

Ako dodajete Bayerov USB mjera¢ CONTOUR®, provijerite je li softver Bayerov GLUCOFACTS®
zatvoren. Provjerite paletu sustava Windows kao $to je prikazano ovdje. Ako vidite ikonu
GLUCOFACTS, desnom tipkom misa kliknite je pa odaberite Exit (Izadi).

1:10FM

Prikazuje se poruka o tome je li povezivanje bilo uspjesno. Ako jest, prijedite na sljededi
korak.

Ako komunikacija nije ispravna, provjerite je li hardver izmedu uredaja i racunala ispravno
povezan. Takoder kliknite BACK (Natrag) na ¢arobnjaku da biste provjerili jesu li podaci koje

ste unijeli ispravni.
Kliknite DONE (Dovrseno).

Mjera¢ se dodaje na bolesnikov popis Active Devices (Aktivni uredaji).

Aktivacija i deaktivacija uredaja

Bolesnikovi se uredaji mogu prema potrebi premjestati s popisa Active Devices (Aktivni uredaji)

na popis Inactive Devices (Neaktivni uredaji) i obrnuto. Uredaj mora biti aktivan da biste s njega

mogli procitati podatke.

MozZete imati neogranic¢en broj mjeraca na popisu Active Devices (Aktivni uredaji), no samo jednu

pumpu. Provjerite Zelite li deaktivirati trenutno aktivnu pumpu prije no $to dodate novu.
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Deaktivacija uredaja

1

Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (Trazenje
bolesnika).

Kliknite Devices (Uredaji) da biste pristupili radnom prostoru Devices (Uredaji) za bolesnika.
Uredaji mogu biti navedeni pod ekvivalentnim nazivom uredaja. Pogledajte Podrzani uredaji

na stranici 2.

Ispod uredaja koji zelite deaktivirati kliknite >> make this device inactive (deaktiviraj taj
uredaj). Uredaj se premjesta na popis Inactive Devices (Neaktivni uredaji).

Ponovna aktivacija uredaja

1

Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (Trazenje
bolesnika).

Kliknite gumb Devices (Uredaji). Prikazuje se radni prostor Devices (Uredaji) za bolesnika.

Uredaji mogu biti navedeni pod ekvivalentnim nazivom uredaja. Pogledajte Podrzani uredaji
na stranici 2.

Kliknite >> activate this device (aktiviraj taj uredaj) ispod uredaja koji zelite aktivirati.

Uredaj se premjesta na popis Active Devices (Aktivni uredaji).

Brisanje uredaja

Slijededi ove korake izbrisat ¢ete uredaj i njegove podatke iz radnog prostora Devices (Uredaji)

i sustava CarelLink Pro:

1

Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (Trazenje
bolesnika).

Kliknite Devices (Uredaji) da biste pristupili radnom prostoru Devices (Uredaji) za
bolesnika.

Uredaji mogu biti navedeni pod ekvivalentnim nazivom uredaja. Pogledajte Podrzani uredaji
na stranici 2.

Provjerite nalazi li se uredaj na popisu Inactive Devices (Neaktivni uredaji). Ako to nije slucaj,
kliknite >> Inactivate this device (Deaktiviraj taj uredaj) pod trenutnim unosom.

Kliknite >> delete this device (izbrisi taj uredaj) ispod uredaja koji zelite izbrisati. Prikazuje se
poruka s upozorenjem da ¢e uredaj i svi podaci iz njega biti uklonjeni iz zapisa o
bolesniku.

Kliknite YES (Da) da biste izbrisali ureda;.

Uredaj i njegovi podaci uklanjaju se iz radnog prostora Devices (Uredaji) i iz programa
CarelLink Pro. Podaci iz tog uredaja viSe nisu dostupni za koristenje u izvje$¢ima.
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Citanje podataka iz uredaja

Podatke iz uredaja mozete dobiti povezivanjem s postoje¢im bolesnikovim ra¢unom u sustavu
CareLink Personal (pogledajte Povezivanje sa sustavom Carelink Personal na stranici 21). Druga je
mogucnost da podatke procitate izravno s uredaja, kao $to je opisano u ovom poglavlju.

CareLink Pro moze procitati podatke iz uredaja bolesnika ako se uredaj nalazi na popisu Active
Devices (Aktivni uredaji) i komunicira s racunalom. Nakon primanja podataka mozete ih koristiti
za stvaranje izvjeSca koja olak3avaju procjenu odrzavanja terapije bolesnika. Kratak opis
dostupnih izvjes¢a mozete pronaci u odjeljku O izvjes¢ima na stranici 42.

Iz pumpe za inzulin CareLink Pro moze prikupljati sljedece podatke:

«  razli¢ite postavke pumpe, kao $to su nacin rada za upozorenje, glasno¢a zvu¢nog signala i
vrijeme

« isporucene koli¢ine bazalnog inzulina

« dogadaji i isporucene koli¢ine u bolusu

« unose u carobnjaku za bolus

« iznose pocetnih ciklusa

« razdoblja prekida

«  ocitanja senzora za glukozu tijekom vremenskog razdoblja kod pumpi sa senzorima

Sustav moze prikupiti podatke i iz sustava Guardian REAL-Time, ukljucujudi:

. ocitanja senzora za glukozu (SG)

«  koeficijentne vrijednosti senzora

«  kalibracijske ¢imbenike senzora

+  markere obroka

« ubrizgavanja inzulina

U sustav je moguce prenijeti i razne informacije pohranjene u mjerac¢u glukoze u krvi tijekom

ocitavanja s uredaja.

UPOZORENJE: otkazite ili dovrsite privremene bazalne ili aktivne boluse i ponistite
eventualno aktivne alarme. Pumpa ¢Ce se zaustaviti radi ocitavanja. Po dovrsetku ocitavanja

provjerite je li pumpa nastavila s radom.

OPREZ: nemojte koristiti daljinski upravlja¢ za pumpu tijekom ocitavanja. Ako je baterija
pumpe slaba, pumpa nece poslati podatke na rac¢unalo. Zamijenite bateriju ako status

baterije upozorava da je slaba.

1 Kliknite karticu bolesnika ili dvokliknite ime bolesnika na tablici Patient Lookup (TraZenje

bolesnika).

2 Provjerite komunicira li bolesnikov uredaj s racunalom (pogledajte Povezivanje uredaja na
stranici 24).
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3 Kliknite Devices (Uredaji) da biste pristupili radnom prostoru Devices (Uredaji) za

bolesnika.

Uredaji mogu biti navedeni pod ekvivalentnim nazivom uredaja. Pogledajte Podrzani uredaji

na stranici 2.

4 Na popisu Active Devices (Aktivni uredaji) pronadite uredaj s kojeg zelite dohvatiti podatke i
provjerite jesu li podaci u polju Choose port (Odabir prikljucka) to¢ni.
Za pumpe kliknite padajuci izbornik Amount of Data (Koli¢ina podataka) i odaberite koliko
podataka iz pumpe Zelite da CareLink Pro procita.

5 Kliknite pridruzeni gumb READ DEVICE (Citanje uredaja).

6 Slijedite upute karakteristi¢ne za uredaj i kliknite OK (U redu).

7 Carelink Pro prikazuje traku napretka koja se azurira i prikazuje koliki je postotak podataka s

uredaja procitan.

Ako kliknete CANCEL (Odustani) tijekom Citanja uredaja, prikazuje se poruka s upozorenjem
da odustajanje od ¢itanja uredaja moze dovesti do gubitka svih dotad procitanih podataka.
Da biste ponovno pokrenuli prijenos, morate kliknuti gumb READ DEVICE (Citanje
uredaja).

- Da biste odustali, kliknite YES (Da).

- Da biste nastavili Citati podatke s uredaja, kliknite NO (Ne).

Kada sustav zavrsi Citanje podataka s uredaja, vidjet ¢ete poruku kojom se potvrduje da je

¢itanje s uredaja dovrseno.

8 Kliknite OK (U redu).
- za pumpe slijedite upute za nastavak rada

Ako CareLink Pro ne moze dohvatiti podatke iz uredaja, upute potrazite u odjeljku o otklanjanju

poteskoca.
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Radni prostor Reports (Izvjesca)

CareLink Pro nudi razli¢ita izvjeS¢a koja vam mogu olaksati pracenje terapije za dijabetes.
Informacije u tim izvjes¢ima temelje se na podacima iz bolesnikovih uredaja i njihovih racuna u

sustavu CareLink Personal.
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Izvje$¢a se mogu generirati na zaslonu, poslati izravno pisacu ili spremiti kao TIFF ili PDF datoteke
koje mozete priloziti izvjeS¢u EMR (Electronic Medical Record - elektronicki medicinski zapis).

Jednim postupkom mozete generirati nekoliko vrsta izvjesca.

Podaci prikazani u tim izvjes¢ima biljeze se s uredaja bolesnika, s njegova ra¢una u sustavu

CareLink Personal ili oboje.

NAPOMENA: u referentnom vodicu za izvjes¢a navedene su dodatne pojedinosti o
komponentama izvjesca, kao i uzorci izvjes¢a. Dokumentu Report Reference Guide
(Referentni vodic¢ za izvjes¢a) moZete pristupiti iz programa CareLink Pro odabirom
mogucénosti Help > View Report Reference Guide (PDF) (Pomo¢ > Pregled referentnog vodica

za izvjeséa) i odgovarajuéeg jezika.

Prije pocetka

Ako zelite da neko vremensko razdoblje bude vidljivo u izvje$¢u, morate imati podatke s uredaja
bolesnika za to vremensko razdoblje. Mozda Cete bolesnikov uredaj morati povezati s raCunalom

da biste prije pokretanja izvje$¢a dobili aktualne podatke.
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Prije pokretanja izvje$¢a obavezno pazljivo proucite korak Provjera postavki izvjeséa. Na tom
mjestu mozete precizno ugoditi izvjeS¢e da bi odrazavalo podatke o bolesniku koje zelite.

Stvaranje izvjesca

U sljede¢im odjeljcima pronaci ¢ete informacije uz koje cete lakse razumjeti dostupna izvjesca i

postupak njihova generiranja.

Ako vec poznajete postupak izvjeScivanja i znate koja biste izvje$ca Zeljeli generirati, mozete
poceti.

Otvaranje radnog prostora Reports (Izvjesca)

Kliknite karticu bolesnika ili gumb Open Patient (Otvori bolesnika) & pa dvokliknite njegovo
ime.

Prikazuje se radni prostor Reports (Izvjesca).

NAPOMENA: da biste provjerili imate li najnovije podatke s uredaja iz bolesnikova racuna u
sustavu CarelLink Personal, kliknite SYNC DATA (Sinkroniziraj podatke).

Odabir razdoblja izvjeséivanja

1 Da biste promijenili vremensko razdoblje obuhvaceno izvjes¢em, kliknite padajuci izbornik

Duration (Trajanje) i odaberite vrijeme (maksimalno je trajanje 12 tjedana).

2 Datumi pocetka i kraja automatski se postavljaju, osim ako ne odaberete moguénost custom
date range (prilagodeni raspon datuma).

NAPOMENA: ako odaberete raspon datuma koji je veéi od dopustenog, prikazuje se
poruka o pogresci. Prilagodite trajanje ili datume.

Ako Zelite prilagodeni raspon datuma, kliknite padajuce izbornike From (Od) ili Through (Do)

i odaberite zeljeni mjesec, datum ili godinu.

Kalendar s podacima

U podrucju podatkovnog kalendara u radnom prostoru Reports (lzvjes¢a) prikazuje se prozor s

podacima izvjeséa za tri mjeseca.
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Plavi stupci predstavljaju podatke o uredaju. Narancasti stupac predstavlja odabrano razdoblje
izvjescivanja. Ako se podaci s uredaja preklapaju s razdobljem izvjes¢ivanja, to znaci da imate
podatke za prikazano razdoblje izvjes¢ivanja ili za jedan njegov dio.
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Podru¢je podatkovnog kalendara prvo prikazuje tri zadnja mjeseca. Da biste vidjeli druge

mjesece, kliknite tipke sa strelicama ¢ # s lijeve ili desne strane prikazanih mjeseci.

Odabir izvora podataka koje Zelite obuhvatiti

1 Ako bolesnik koristi mjera¢ razine glukoze u krvi povezan s pumpom, kliknite da biste
odabrali jednu od sljede¢ih mogucnosti za koriStenje podataka mjeraca o razini glukoze u
krvi u izvjescu:

- In the pump (u pumpi): prednosti su te moguénosti to $to morate procitati podatke samo
s bolesnikove pumpe, pumpa oznacava vrijeme na ocitanjima razine glukoze u krvi, a
oditanja su izravno povezana s izra¢unima ¢arobnjaka za bolus. No ako postoje
poteskoce u komunikaciji izmedu pumpe i povezanog mjeraca, u tom razdoblju mozda
nece biti prijavljena ocitanja razine glukoze u krvi. Osim toga, ako je model pumpe
MiniMed Paradigm koju koristite stariji od 522/722, ocitanja razine glukoze u krvi iz
izraCuna Carobnjaka za bolus na koja niste reagirali nece udi u izvjesce.

- In the link meter(s) (U povezanom mjeracu): prednost je te mogucnosti prijava svih
ocitanja pohranjenih u povezanom mjeracu. Nedostatak je to $to ste radi korelacije
podataka iz mjeraca i pumpe prethodno morali provijeriti jesu li pumpa i mjerac
medusobno sinkronizirani. Takoder morate zasebno procitati podatke iz pumpe i

povezanog mjeraca.
2 Da biste podatke iz uredaja dodali u izvjes¢a, potvrdite okvir pored relevantnog uredaja.

Ne mozete dodati uredaje koji su bili isklju¢eni zbog vaseg odabira u 1. koraku. Da biste to

promijenili, odaberite drugu mogucnost povezanog mjeraca.

3 Da biste podatke iz uredaja izostavili iz izvjeSca, ponistite potvrdni okvir pokraj relevantnog
uredaja.

Ne mozete ponistiti potvrdne okvire uz moguénost koju ste odabrali u 1. koraku. Da biste to
promijenili, odaberite drugu mogucnost povezanog mjeraca.

Provjera ima li podataka u uredaju

1 U kalendaru s podacima u radnom prostoru Reports (Izvje$¢a) provjerite preklapa li se
narancasti stupac, koji predstavlja razdoblje izvjes¢ivanja, s plavim stupcima koji predstavljaju
podatke o uredaju.
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Ako se trake preklapaju tijekom cijelog razdoblja izvjeséivanja, raspolazete podacima za
izvjeSce. Mozete kliknuti NEXT (Dalje) i prije¢i na odjeljak Provjera postavki izvjes¢a na
stranici 40.

Ako se trake ne preklapaju ili ako nema dovoljno preklapanja, mozZete odabrati jednu od
sljedec¢ih moguénosti:

- prilagodite razdoblje izvje$civanja;

- preuzmite dodatne podatke iz uredaja.

Preuzimanje dodatnih podataka iz uredaja

1

Da biste preuzeli vie podataka s uredaja, kliknite gumb READ DEVICE (Citanje uredaja)
pridruzen uredaju.

Prikazuje se traka Read Device (Citanje uredaja).
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UPOZORENUJE: otkazite ili dovrsite privremene bazalne ili aktivne boluse i ponistite
eventualno aktivne alarme. Pumpa ce se zaustaviti radi oéitavanja. Po dovrsetku
ocitavanja provjerite je li pumpa nastavila s radom.

OPREZ: nemojte koristiti daljinski upravlja¢ za pumpu tijekom ocitavanja. Ako je
baterija pumpe slaba, pumpa nece poslati podatke na racunalo. Zamijenite bateriju ako
zaslon sa statusom baterije upozorava na to da je slaba.

Provijerite jesu li podaci u polju Choose port (Odabir prikljucka) ispravni za taj uredaj.

Da biste promijenili tu postavku, kliknite padajuci izbornik za to polje i odaberite neku drugu
postavku.

Provjerite je li uredaj povezan s vasim racunalom.

Ako je uredaj pumpa, mozete odrediti koliko ¢ete podataka iz nje preuzeti. Kliknite padajudi
izbornik Amount of Data (Koli¢ina podataka) i odaberite koli¢inu.

NAPOMENA: ako odaberete All available data (Svi dostupni podaci), sustav ¢e procitati
sve podatke u pumpi. Time cete prebrisati sve postojece udvostrucene podatke u
sustavu.

Kliknite READ DEVICE (Citanje uredaja). Obavezno paZzljivo procitajte prikazanu poruku jer su
u njoj navedene specifi¢cne upute za ocitavanje pumpe.

Slijedite upute i kliknite OK (U redu).
Prikazuje se traka napretka pri ¢itanju s uredaja.
U bilo kojem trenutku moZete odustati od ¢itanja klikom na CANCEL (Odustani).

Po dovrsetku citanja prikazuje se poruka s potvrdom.
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Kliknite OK (U redu).

Podaci s uredaja sada su vidljivi na kalendaru s podacima.

Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports (Izvjesca).

Prikazuje se korak Verify Report Settings (Provjera postavki izvjes¢a). On omogucuje provjeru

ispravnosti postavki za tog bolesnika prije pokretanja izvjesca.

Provjera postavki izvjesca

1

Provjerite jesu li postavke za vrijednost Glucose Target (Ciljana glukoza) u skladu sa zZeljenim

postavkama. Upisite te vrijednosti ili kliknite strelice prema gore ili dolje u poljima Low

(Donja) i High (Gornja) da biste povecali ili smanijili vrijednosti.

NAPOMENA: markeri za oéitavanje mjeraca (|| |) prikazuju se na krivulji budenja i

spavanja, kao i na krivulji obroka. Buduéi da se neka od ovih izvjes¢a temelje na

podacima iz odredenih vremena obroka, budenja ili spavanja, vazno je da markeri

bolesnikovih Bolus Wizard dogadaja i oéitanja mjeraéa budu ispravno grupirani.

Da biste dodali novo razdoblje obroka, kliknite ADD MEAL (Dodaj obrok). Da biste uredili
postojece razdoblje obroka, kliknite bilo gdje unutar jednog od razdoblja obroka na

vremenskoj crti.

Aktivira se uredivac razdoblja obroka koji se nalazi ispod vremenske crte.

NAPOMENA: moZete odrediti do pet razdoblja obroka. Zadani su dorucak, ruéak i

vecera.

Unesite tekst ili kliknite strelice da biste odabrali Zeljene postavke.

Ako te postavke Zelite koristiti samo za taj obrok, ponistite potvrdni okvir Use these

parameters for all of this patient’s meals (Koristi te parametre za sve obroke ovog

bolesnika).

Meal Name (Naziv obroka): naziv koji zelite dodijeliti razdoblju obroka

Meal Time Period (Vrijeme obroka): sati izmedu kojih se obrok konzumira

Pre-Meal BG Target (mg/dL or mmol/L): (Raspon ciljane glukoze u krvi prije obroka
(mg/dL ili mmol/L)): donje i gornje vrijednosti ciljanog raspona glukoze u krvi bolesnika
prije obroka

Pre-Meal Analysis Period vremensko razdoblje u kojemu ce se analizirati glukoza prije
pocetka obroka. Ocitanja glukoze zabiljeZena tijekom tog razdoblja koriste se za detaljnu
analizu izvjeséa

Post-Meal BG Target (mmol/L or mg/dL): (Raspon ciljane glukoze u krvi poslije obroka
(mmol/L ili mg/dL)): donje i gornje vrijednosti ciljanog raspona glukoze u krvi bolesnika
poslije obroka

Post-Meal Analysis Period vremensko razdoblje u kojemu ¢e se analizirati glukoza
nakon obroka. Oc¢itanja glukoze zabiljeZzena tijekom tog razdoblja koriste se za detaljnu

analizu izvjesc¢a
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Duljinu postojeceg razdoblja obroka ili razdoblja budenja i odlaska na spavanje mozete
promijeniti tako da kliknete rucice pocetka ili zavrsetka te ih povucete i ispustite duz
vremenske crte.

NAPOMENA: razdoblja obroka ne smiju se preklapati, no pocetne i zavrsne crte smiju
medusobno graniéiti. Razdoblja obroka moraju trajati barem 60 minuta.

Da biste postavke za taj obrok koristili za sve druge obroke bolesnika, provjerite je li potvrden
okvir Use these parameters for all of this patient’s meals (Koristi te parametre za sve
obroke ovog bolesnika).

Kada stvorite ili uredite razdoblje obroka, kliknite SAVE (Spremi).

Da biste uklonili razdoblje obroka, kliknite DELETE MEAL (Izbrisi obrok). Kliknite DELETE
(Izbrisi) kada se od vas zatrazi da potvrdite odluku.

CareLink Pro moze zapamtiti postavke za tog bolesnika za sljedec¢i put kada budete pokretali
izvjeS¢e za njega. Da biste spremili postavke za tog bolesnika, kliknite SAVE SETTINGS
(Spremi postavke).

Kliknite NEXT (Dalje) pri vrhu radnog prostora Reports (Izvjesca).

Time pokrecete korak Select and Generate Reports (Odabir i generiranje izvje$c¢a). Taj korak
pruza popis vrsta izvjedca i podatkovnu tablicu uz koju cete lakSe odluciti hocete li uvrstiti ili
izostaviti odredene dane s podacima iz izvjes¢a Daily Detail (Dnevne pojedinosti).
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NAPOMENA: da biste izmijenili prikaz podatkovne tablice, kliknite >>customize columns
(prilagodi stupce). Pogledajte Preference generiranja izvies¢a na stranici 16.

9 Da biste ispisali podatke sa zaslona, kliknite ikonu za ispis PRINT (Ispis) .

Odabir vrsta izvjeSca i datuma uvrstavanja

1

Potvrdite okvir pokraj izvjeséa koje zelite uvrstiti u skup izvjesca.

NAPOMENA: potvrdni okvir izvies¢a Dashboard/Episode Summary (Sazetak nadzorne
ploce / epizoda) nece biti dostupan ako je u odabranom vremenskom razdoblju manje

od pet dana podataka senzora ili pumpe ili ako podaci u tom razdoblju potjecu s
monitora Guardian.

CareLink Pro Korisnicki priru¢nik  Radni prostor Reports (Izvjes¢a) 41



Ako su tijekom tog razdoblja izvje$céivanja podaci s pumpe ili monitora Guardian ocitani vise
puta, mozda ¢e postojati vise snimki uredaja:
a. Provjerite je li potvrden okvir Device Settings Snapshot (Snimka postavki uredaja).
b. Kliknite padajucu strelicu i odaberite datum i vrijeme snimke.
- Pumpa: odaberite snimku s pumpe bolesnika
- Guardian: odaberite snimku s bolesnikova monitora Guardian

Ako je bilo koje od polja zatamnjeno, nema dostupnih snimki tijekom razdoblja

izvjescivanja.

Prolistajte podatkovnu tablicu da biste pregledali dostupne podatke iz izvjeS¢a Daily Detail

(Dnevne pojedinosti).

- Mozete sortirati podatke u svakom stupcu. Kliknite naslov stupca da biste sortirali
podatke uzlaznim redoslijedom. Ponovno kliknite naslov da biste sortirali podatke
silaznim redoslijedom.

NAPOMENA: ako nema podataka za odredeni datum, taj datum nije moguce odabrati.

Potvrdite okvir u recima tablice Data Table (Tablica s podacima) za svaki datum za koji zelite

izvjes¢e Daily Detail (Dnevne pojedinosti).

- Da biste jednim klikom uvrstili ili izostavili sve datume izvje$¢a Daily Detail (Dnevne
pojedinosti), potvrdite ili ponistite okvir pri vrhu stupca s potvrdnim okvirima tablice
Data Table (Tablica s podacima).

Generiranje izvjesca

1

Nakon 3$to provjerite odabire izvjesc¢a, kliknite GENERATE REPORTS (Generiranje izvjescéa) pri
vrhu radnog prostora Reports (Izvjesca).

Prikazuje se popis mogucnosti.

Odaberite mogucnost za pretpregled, ispis ili spremanje izvjesca.

Ako ste odabrali Preview (Pretpregled), prikazuje se prozor Preview (Pretpregled).

Kliknite tipke sa strelicama da biste se kretali kroz izvjeséa koja sadrze vise stranica.
Kliknite jedan od ostalih gumba pri vrhu prozora Preview (Pretpregled) da biste spremili ili
ispisali izvjesce.

tds b bl @ e w @ T Dot toFDE | ] ixport bo TIT | 5 Prink | '] Report Relorence Guide « | [ Clowe

Da biste zatvorili taj prozor, kliknite gumb Close (Zatvori) E u gornjem desnom kutu

prozora.

Oizvjes¢ima

Ovaj odjeljak sadrzi opis svakog izvjesca. U referentnom vodicu za izvjeS¢a navedene su dodatne

pojedinosti o komponentama izvjeséa, kao i uzorci izvjeséa. Referentnom vodicu za izvjeséa

mozete pristupiti iz programa CareLink Pro:
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1 Help > View Report Reference Guide (PDF) (Pomoc¢ > Prikaz referentnog vodica za izvjesca
(PDF)).

2 Odaberite jezik referentnog vodica za izvjesca.
Izvjes¢a softvera CarelLink Pro imaju ove zajednicke elemente:

«  Report header (Zaglavlje izvje$¢a) — zaglavlje izvje3ca sadrzi podatke za identifikaciju,
primjerice naziv izvje$ca, ime bolesnika i izvor podataka.

«  Carbohydrates and blood glucose levels (Razine ugljikohidrata i glukoze u krvi) - u
grafikonima i dijagramima jedinice ugljikohidrata prikazane su kurzivom, a razine glukoze u
krvi podebljano.

+  Weekend data (Podaci o vikendu) — dani vikenda podebljani su da biste ih mogli

jednostavno prepoznati.

« Legends (Kazalo) - kazalo simbola pojavljuje se pri dnu svakog izvjes¢a. Dok je simbol
moguce koristiti u vise izvjesca, kazala su jedinstvena za svako izvjesce.

Sazetak nadzorne ploce i epizoda

Sazetak nadzorne ploce i epizoda dvostrano je izvjeS¢e koje sluzi kao sazetak ukupne glikemijske
kontrole bolesnika za odabrano razdoblje. Prva stranica izvjeS¢a naziva se Therapy Management
Dashboard (Nadzorna ploc¢a praéenja terapije), a druga Episode Summary (Sazetak epizoda). U

nastavku su opisane obje stranice.

Nadzorna ploca pracenja terapije

Nadzorna praéenja terapije omogucuje vam pregled ukupne razine glikemijske kontrole po dijelu
dana. Na stranici nadzorne ploce iscrtavaju se senzorski tragovi slike glukoze i informacije o
davanju inzulina na dnevnom grafu. Na nadzornoj ploci prikazuju se i razdoblje spavanja te
razdoblja oko obroka, sto pridonosi procjeni glikemijske kontrole prije i poslije obroka. Pomocu
tih grafova mozete prepoznati klju¢ne klinicke uzorke, kao sto su hiperglikemija, hipoglikemija i
varijabilnost unutar ukupnog grafi¢ckog prikaza glikemijske kontrole. Nadzornoj plo¢i pridodana je
statisticka analiza uzoraka hipoglikemije i hiperglikemije koji se ponavljaju u odredeno doba
dana.

Nadzorna ploca, k tome, omogucuje koreliranje glikemijske kontrole po dobu dana s klju¢nim
terapijskim modifikatorima kao sto su osnovi uzorak, apsorpcija inzulina, osjetljivost inzulina i
omjeri ugljikohidrata. To smanjuje potrebnu za ru¢nim koreliranjem dogadaja s vise izvjeS¢a. Na
koncu, na nadzornoj plo¢i prikazuju se ukupni statisticki podaci o koristenju pumpe i senzora.

Sazetak epizoda

Na stranici saZetka epizoda prikazuju se pojedinosti o hipoglikemijskim i hiperglikemijskim
epizodama. Na njoj su istaknute najkriti¢nije epizode i ucestalost koreliranih dogadaja zanimljivih
za daljnje istrazivanje. Ako je moguce, na izvjes¢u se numeriraju Cesti poznati uzroci
hipoglikemijskih i hiperglikemijskih ispada i daju upute za terapiju.

Na koncu, sazetak epizoda nudi ukupna opazanja o klju¢nim mjerama ponasanja i pridrzavanja
vezanih uz koristenje inzulinske pumpe, sustava za kontinuirano pracenje glukoze i mjeraca
GUK-a. Ta opazanja ne moraju biti vezana uz epizode.
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Izvjesce o pridrzavanju propisane terapije

U izvjes¢u Adherence Report (IzvjeS¢e o pridrzavanju propisane terapije) prikazani su podaci koji
opisuju kako se koriste inzulinske pumpe i senzori, a opisano je i ponasanje bolesnika relevantno
za terapiju koju primaju. Ono odgovara na pitanje: "Postoji li dovoljno podataka za davanje to¢ne
slike o nac¢inu na koji bolesnik koristi inzulinsku pumpu i senzor?" Odgovara i na pitanje:
"Pridrzavaju li se bolesnici propisane terapije?" Izvjesc¢e, k tome, daje naznake o tome trebate li
razgovarati s bolesnikom o njegovu nacinu kontrole dijabetesa.

IzvjeSce s pregledom senzora i mjeraca

IzvjeSce o pregledu senzora i mjeraca pruza graficki prikaz dnevnih razina i prosjeka glukoze u krvi
bolesnika dobivenih iz mjeraca, ukljucujudi i podatke za svaki sat tijekom 24 sata te njihov odnos s
uzorcima obroka i spavanja. Uvrsteni su i statisti¢ki podaci o ocitanjima razine glukoze u krvi
bolesnika i koriStenju inzulina.

Ako su dostupni podaci iz senzora, generira se sli¢na analiza podataka iz senzora kao prva stranica
ovog izvjes¢a. Ako podaci iz senzora nisu dostupni, stranica s analizom podataka mjeraca generira

se kao prva stranica.

Na zadnjoj stranici izvje$c¢a prikazane su dnevne razine i kvaliteta kontrole glukoze, ugljikohidrata
i inzulina bolesnika. Na svakoj je stranici prikazano kako kontrola varira svakog dana tijekom
cijelog razdoblja izvjesc¢ivanja do najvise 14 dana po stranici.

IzvjeSce zapisnika

IzvjeSce zapisnika prikazuje podatke o mjerac¢u glukoze, ugljikohidratima i inzulinu za svaki dan
odabranog razdoblja. Ono sadrzi dnevnik dogadaja zabiljeZenih svakog sata te dnevne prosjeke i
ukupne podatke. Svaka stranica sadrzi podatke za najvise 14 dana. Ako razdoblje izvjes¢ivanja

premasuje 14 dana, generiraju se dodatne stranice.

Snimka postavki uredaja

U izvjes¢u Device Settings Snapshot Report (Snimka postavki uredaja) prikazuje se snimka
postavki bolesnikove pumpe ili monitora Guardian REAL-Time za odredeni datum i vrijeme. To
vam moze olaksati razumijevanje drugih izvjesc¢a ili posluZiti za jednostavno dokumentiranje
postavki bolesnika.

Postavke pumpe ili monitora snimaju se samo pri ocitavanju uredaja. Ako uredaj nije ocitan
tijekom razdoblja izvjes¢ivanja, nikakve postavke nece biti dostupne.

IzvjeSée o dnevnim pojedinostima

U izvjeS¢u s dnevnim pojedinostima prikazani su podaci o razini glukoze, koli¢ini ugljikohidrata i
bolesnikovu koristenju inzulina za odabrani dan. Za svaki dan koji odaberete iz podatkovne

tablice generira se zasebno izvjesce.

IzvjeSc¢e Daily Detail Report (Dnevne pojedinosti) pruza detaljan uvid u odabrani dan. Ono vam
omogucuje da se usredotocite na odredeni dan ako smatrate da se tada dogodilo nesto vazno za

terapiju bolesnika.
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Izvoz podataka

Mozete izvesti podatke s uredaja koje je CareLink Pro pribavio i pohranio. Tako sve podatke s

uredaja bolesnika mozete koristiti u statistikama ili za stvaranje specijaliziranih izvjeséa ili

grafikona. Datoteku .csv mozete uvesti u Microsoft Excel ili neke programe za klini¢ku statistiku te

zatim njima dalje upravljati.

Datoteka .csv sadrzi podatke u kojima su zabiljeZzene radnje uredaja. Navedeni su, primjerice,

snimka ocitanja mjeraca, pumpa koja prima vrijednost ocitanja mjeraca ili promjena bazalnog

ritma.

NAPOMENA: to je napredna znacajka za koju morate poznavati neobradene podatke s

uredaja. Potrebno je i dobro poznavanje softvera u koji cete uvesti .csv datoteku.

Slijedite ove korake da biste koristili znacajku izvoza programa CareLink Pro:

1

Kliknite karticu bolesnika ili gumb Open Patient (Otvori bolesnika) & pa dvokliknite
njegovo ime.

Provjerite je li otvoren radni prostor Reports (Izvjesca).

Koristite polje Duration (Trajanje) ili From/Through (Od/Do) da biste postavili datume i
duljinu izvjesca.

Maksimalno trajanje koje mozete odabrati iznosi 12 tjedana.

Kliknite vezu export selected data (izvoz odabranih podataka).

Prikazuje se dijaloski okvir Export Data to CSV File (Izvoz podataka u CSV datoteku).

Idite na mjesto na ra¢unalu na kojem Zelite spremiti .csv datoteku. Ako zZelite promijeniti

naziv datoteke, upisite ga u okvir File name (Naziv datoteke).

Kliknite SAVE (Spremi).

NAPOMENA: dodatne informacije o podacima prikazanima u CSV datotekama potrazite
u odjeljku o CSV podacima.

Datoteka s nastavkom .csv sada je spremljena na odabranom mjestu na vasem racunalu. Sada
mozete izvrsiti njezin uvoz u bilo koji program koji podrzava tu vrstu datoteka.
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Administracija sustava

Vazno je da redovito stvarate sigurnosne kopije baze podataka programa CareLink Pro. U bazi
podataka pohranjeni su svi sistemski podaci akumulirani u zapisima o bolesniku, uklju¢ujudi
informacije o profilu, podatke dobivene iz uredaja i postavke izvjesca.

Vazno je i da imate najnoviju verziju programa CarelLink Pro. S vremena na vrijeme dostupne su
azurirane verzije koje mogu sadrzavati vazna poboljsanja. Mozete potraziti azuriranja ili primiti
obavijest kada su azuriranja dostupna.

Primjena aZzuriranja softvera

Povremeno su dostupna azuriranja programa Carelink Pro. Kada se prikaze obavijest o
azuriranju, poduzmite slijedece korake da biste preuzeli najnovije izdanje softvera.

NAPOMENA: prije primjene aZuriranja softvera potrebno je stvoriti sigurnosnu kopiju baze
podataka. Pogledajte Stvaranje sigurnosne kopije baze podataka na stranici 47.

1 Provjerite je li internetska veza dostupna i aktivna na vasem racunalu.

2 Kada je azuriranje za CarelLink Pro dostupno, prikazuje se poruka o azuriranju. Nudi se
mogucnost preuzimanja azuriranja.

3 Kliknite DOWNLOAD (Preuzimanje). (Ako kliknete CANCEL (Odustani), obavijest o azuriranju

zatvorit ¢e se. Azuriranje mozete preuzeti kasnije.)

Prikazuje se poruka upozorenja u kojoj se preporucuje da stvorite sigurnosnu kopiju baze
podataka.

4 Kliknite YES (Da) da biste stvorili sigurnosnu kopiju baze podataka (opis tog postupka
potrazite u odjeljku Stvaranje sigurnosne kopije baze podataka na stranici 47). Kliknite gumb
NO (Ne) ako ste ve¢ obavili sigurnosno kopirali podatke.

Prikazat ¢e se poruka kojom se potvrduje da je preuzeta nova verzija programa CareLink
Pro.

CareLink Pro Korisnicki priru¢nik ~ Administracija sustava 46



5 Da biste poceli koristiti najnoviju verziju programa CareLink Pro, kliknite YES (Da) da biste
zatvorili i ponovno otvorili program. Kliknite NO (Ne) ako ne zelite odmah ponovno pokrenuti
CarelLink Pro.

Isklju¢ivanje automatskih azuriranja

Ako ne Zelite primati automatske obavijesti o azuriranjima programa CareLink Pro, slijedite ove
korake:

1 Odaberite Tools > Options (Alati, Mogucnosti).
2 Kliknite karticu General (Opcenito).
3 U odjeljku Communications (Komunikacija), ponistite potvrdni okvir Automatically check for

software updates (Automatski provjeri ima li azuriranja softvera).

Ruéna provjera dostupnosti azuriranja

U svakom trenutku mozete rucno provijeriti jesu li dostupna azuriranja za CareLink Pro.

NAPOMENA: prije primjene aZuriranja softvera potrebno je stvoriti sigurnosnu kopiju baze
podataka. Pogledajte Stvaranje sigurnosne kopije baze podataka na stranici 47.

1 Provjerite je li internetska veza dostupna i aktivna na vasem racunalu.

2 Odaberite Tools > Check for Software Updates (Alati, Provjeri ima li azuriranja

programa).

3 Ako trenutno nema dostupnih azuriranja, primit ¢ete poruku. Ako je azuriranje dostupno,
prikazuje se poruka o azuriranju softvera CareLink Pro.

4 Slijedite postupak u odjeljku Primjena azZuriranja softvera na stranici 46.

Stvaranje sigurnosne kopije i povrat baze podataka

Preporucujemo da uspostavite redoviti raspored prema kojem ¢ete stvarati sigurnosne kopije
baze podataka. Na taj ¢ete nacin osigurati redovito obavljanje tog zadatka i minimizirati rizik
gubitka podataka.

Ako stvarate sigurnosnu kopiju ili vracate bazu podataka, pojavit ¢e se upozorenje ako na drugim

racunalima korisnici aktivno koriste program.

Stvaranje sigurnosne kopije baze podataka
Sljedeci koraci opisuju sigurnosno kopiranje trenutne baze podataka na mjesto koje odaberete.
1 Provjerite jesu li svi zapisi o bolesnicima zatvoreni.

2 Odaberite Tools > Backup Database (Alati > Sigurnosno kopiranje baze podataka).

NAPOMENA: sigurnosne kopije baze podataka mogu se spremiti na mrezni pogon ili na
izmjenjivi medij za pohranu (DVD, CD ili USB pogon).
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3 Idite na mjesto na racunalu na kojem Zelite spremiti sigurnosnu kopiju. Ako Zelite promijeniti
naziv datoteke sigurnosne kopije, upisite ga u okvir File name (Naziv datoteke).

4 Kliknite Spremi. Traka napretka prikazuje se tijekom spremanja baze podataka.
Kada je sigurnosno kopiranje dovrseno, prikazuje se poruka.

5 Kliknite OK (U redu) da biste zatvorili poruku.

Povrat baze podataka

Mozda je potrebno zamijeniti trenutnu bazu podataka ako joj viSe nije moguce pristupiti ili je
vide nije moguce koristiti. Sto je vasa sigurnosna kopija azurnija, izgubit ¢ete manje podataka
ako zamijenite bazu podataka.

OPREZ: kada izvrsite povrat sa sigurnosnom kopijom, gubite sve nove podatke stvorene od
trenutka kada ste nacinili odabranu sigurnosnu kopiju.

Sljedeci koraci opisuju odabir sigurnosne kopije kojom cete zamijeniti trenutnu bazu podataka.
1 Provjerite jesu li svi zapisi o bolesnicima zatvoreni.
2 Odaberite Tools > Restore Database (Alati > Povrat baze podataka).

3 Odaberite datoteku sigurnosne kopije kojom Zelite zamijeniti trenutnu bazu podataka
(obi¢no je to najnovija).

4 Kliknite Open (Otvori). Prikazuje se poruka s upozorenjem da ¢ete mozda izgubiti podatke
ako nastavite vracanje baze podataka.

5 Da biste nastavili, kliknite OK (U redu). Traka napretka prikazuje se tijekom povrata baze
podataka.

Po zavrSetku povrata baze podataka prikazuje se poruka.

6 Klikom na OK (U redu) zatvorite poruku.

Ako sustav nije dostupan

Ako pokusate pokrenuti sustav dok drugi korisnik izvrSava sigurnosno kopiranje ili vracanje,
prikazat ¢e se poruka s obavijesti da sustav nije dostupan. Necete mocdi pristupiti sustavu dok se
zadatak ne dovrsi.

Ucinite nesto od navedenog:
«  Pricekajte da postupak zavrsi i da sustav postane dostupan.

«  Kliknite CANCEL (Odustani) da biste izasli iz programa i pokusali ponovno kasnije.

CareLink Pro Korisnicki priru¢nik ~ Administracija sustava 48



Otklanjanje poteskoca

Ovo poglavlje olak3at ¢e vam rjeSavanje problema do kojih moze dodi tijekom koristenja
programa CareLink Pro. Ono sadrzi i upute za eventualnu deinstalaciju programa CareLink Pro.

Opce pogreske pri koristenju programa

Ako pokusate preuzeti nadogradnju softvera putem interneta, mogli biste primiti poruku da
nemate dovoljne ovlasti za to. Morate imati administrativne ovlasti da biste preuzimali

nadogradnje za program CareLink Pro.
1 Zatvorite CareLink Pro i ponovno pokrenite racunalni sustav.
2 Neka se osoba s administrativnim ovlastima prijavi na racunalo.

3 Slijedite upute u odjeljku Primjena azZuriranja softvera na stranici 46.

Ne postoji veza s bazom podataka

Poruka o pogresci koja vas upozorava da niste povezani s bazom podataka upucuje na nesto od
navedenog:

« Baza podataka je premjeStena. Baza podataka mora se nalaziti na mjestu koje ste odabrali
tijekom instalacije programa CareLink Pro. Ako je premjestena, morate je vratiti na mjesto
odabrano tijekom instalacije.

«  Niste povezani s mreznim pogonom na kojem se baza podataka nalazi. Ako se baza podataka
nalazi na mreZznom pogonu, na mrezi se povremeno mogu pojaviti problemi koji mogu
sprijeciti pristupanje pogonu. Obratite se odjelu za ra¢unalnu podrsku da biste dobili pomo¢

za ponovno povezivanje s mreznim pogonom na kojem se nalazi baza podataka.
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Zaboravili ste lozinku ambulante za CareLink Pro

Ako se nitko ne moze sjetiti lozinke koju vasa ustanova koristi za prijavu u CarelLink Pro, morate

ponovno instalirati program i stvoriti novu bazu podataka. Kada ponovno instalirate softver,

necete moci pristupiti informacijama o bolesniku koje su se nalazile u prijasnjoj bazi podataka.

Lozinku koju stvorite tijekom nove instalacije pohranite negdje u uredu da ne biste izgubili

buduce podatke.

Pogreska pri ¢itanju uredaja

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is available, or select another port.
(Nije bilo moguce otvoriti odabranu serijsku
priklju¢nicu. Mozda je u tijeku neka druga operacija na
toj priklju¢nici. Pricekajte dok priklju¢nica ne postane
dostupna ili odaberite neku drugu priklju¢nicu.)

Provjerite ne koristi li neki drugi program odabranu
komunikacijsku priklju¢nicu ili odaberite neku drugu
priklju¢nicu. Pokusajte ponovno pokrenuti ra¢unalo
koje koristite i potom ponovno proditati uredaj. Mozda
je neispravan hardver (kabel itd.) povezan s
priklju¢nicom ili sama priklju¢nica. PovezZite hardver s
nekom drugom priklju¢nicom i ponovno pokusajte
procitati uredaj da biste lakse odredili problem.

Auto Detect could not find the device on any
available port. Please check the cable connection,
device battery & status and try again, or try specifying
a serial port. (AutoDetect nije uspio pronaci uredaj na
dostupnoj priklju¢nici. Provjerite kabelsku priklju¢nicu,
bateriju i stanje uredaja i pokusajte ponovno ili
pokusajte specificirati serijsku priklju¢nicu.

Provjerite vezu izmedu kabela i racunala te provjerite
je li status baterije uredaja zadovoljavajuci. Ako jest,
umjesto odabira znacajke automatskog otkrivanja
pokusajte odrediti serijsku priklju¢nicu racunala s
kojom je kabel povezan.

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device. (Uredaj nije pronaden na odabranoj
serijskoj priklju¢nici. Provjerite kabelsku vezu, bateriju
uredaja i status pa pokusajte ponovno ili pokusajte
odabrati neku drugu priklju¢nicu ili automatski otkriti
uredaj.)

Provjerite vezu izmedu kabela i ra¢unala te provjerite
je li status baterije uredaja zadovoljavajuci. Ako jest,
pokusajte odabrati neki drugi broj serijske priklju¢nice
racunala ili odaberite moguc¢nost automatskog
otkrivanja.

Unable to communicate with the device. Please ensure
you've attached and selected the correct device, check
the cable connection, device battery and status, and
try again. (Komunikacija s uredajem nije moguca.
Provjerite jeste li prikljucili i odabrali odgovarajudi
uredaj, provjerite kabelsku vezu, bateriju uredaja i
status pa pokusajte ponovno.)

Provjerite sve odabrane postavke za citanje uredaja,
uklju¢ujudi naziv uredaja, serijski broj i vrstu veze.
Provjerite uz to jesu li uredaj, kabel i racunalo
ispravno povezani. Provjerite jesu li baterija i status
alarma uredaja zadovoljavajuci. Ponovno pokusajte
izvrditi Citanje.

Unexpected response... retrying (n%) (Neocekivani
odgovor... pokusavam ponovno (n%))

S uredaja je procitana neocekivana vrijednost. Sustav
pokusava ponovno uspostaviti komunikaciju sve dok
ne odustanete ili dok komunikacija ne uspije.

The link device was found, but the device (<serial #>)
is not responding. Please verify the pump’s serial
number, place the pump closer to the communication
device to minimize interference, check pump battery
and status. (Komunikacijski je uredaj pronaden, no
pumpa (serijski br.) ne odgovara. Provjerite serijski broj
pumpe, postavite je blize komunikacijskom uredaju da
biste minimizirali smetnje te provjerite bateriju pumpe
i status.)

Provjerite jeste li unijeli ispravan serijski broj pumpe.
Ako niste, ponovno unesite ispravan serijski broj. Ako
je serijski broj ispravan, pokusajte uredaj za
povezivanje pribliziti komunikacijskom uredaju.
Pomaknite uredaj za povezivanje i komunikacijski
uredaj podalje od mogucih smetnji (primjerice RF
uredaja). Provjerite bateriju uredaja i, ako ucitavate
pumpu za inzulin, provjerite stanje rada pumpe.

This pump is delivering a temp basal. Please cancel
the temp basal or wait until it completes, and then try
again. (Pumpa isporucuje priviemenu bazalnu dozu.
Otkazite bazalnu dozu ili pri¢ekajte dok ne zavrsi, a
zatim pokusajte ponovno.)

Pumpa koju pokusavate procitati isporucuje
priviemenu bazalnu dozu. Pricekajte dok privremena
bazalna isporuka ne zavrsi da biste procitali pumpu ili
otkazite privremenu bazalnu dozu i potom procitajte
pumpu.
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Pogreska

Objasnjenje

This pump has active errors or alarms. Please clear the
alarms and try again. (Na pumpi su aktivne pogreske
ili alarmi. Ponistite alarme i pokusajte ponovno.)

Na pumpi su aktivni alarmi koji sprjecavaju citanje.
Procitajte upute za alarm da biste doznali kako ga
ponistiti. Ponistite alarm i pokusajte ponovno procitati
pumpu.

This pump is delivering a bolus. Please cancel the
bolus or wait until it completes, and then try again.
(Pumpa isporucuje bolus. Otkazite bolus ili pricekajte
dok ne zavrsi, a zatim pokusajte ponovno.)

Pumpa koju pokusavate procitati isporucuje bolus.
Pricekajte dok bolus ne zavrsi da biste procitali pumpu
ili odustanite od bolusa i potom procitajte pumpu.

The device returned invalid entries; all data read will
be discarded. (Uredaj je poslao nevaljane unose; svi
procitani podaci bit ¢e odbaceni.)

Obratite se lokalnom predstavniku u svojoj zemlji
(pogledajte odjeljak Pomo¢ na stranici 2).

Pogreske pri stvaranju izvjesca

ViSe podatkovnih unosa za isti datum

Ako postoji vise podatkovnih unosa za isti datum i vrijeme za isti uredaj, sustav ¢e to protumacditi

kao sukob koji nije moguce razrijesiti. Izvjes¢a stvorena pomocu tih podataka s uredaja nece

sadrzavati podatke koji se preklapaju.

MozZete pokusati prilagoditi razdoblje izvjes¢a da biste zaobisli podatke koji se preklapaju ili

ukloniti uredaj iz sustava i potom ga vratiti da biste ponistili prethodna ocitanja.

Sustav ignorira podatke

Ako je vrijeme na uredaju promijenjeno te rezultira preklapanjem podataka ili prazninama izmedu

podataka u trajanju od tri sata ili dulje, sustav ne uvrstava taj dio podataka pri stvaranju

izvjesca.

Pogreske prilikom sigurnosnog kopiranja i vraéanja

Bazu podataka nije moguce zakljucati

To znadi da sustav koristite u okruzenju s vise korisnika, a drugi su korisnici prijavljeni. Sustav nece

dopustiti stvaranje sigurnosne kopije baze podataka dok drugi korisnici izvrSavaju zadatke koji

mogu utjecati na bazu podataka. Nakon Sto svi korisnici izadu iz programa CareLink Pro, mozete

stvoriti sigurnosnu kopiju baze podataka.

Sigurnosno kopiranje ili vraéanje baze podataka ne izvrSava se do kraja

Drugi se korisnici ne mogu prijaviti, a sigurnosno kopiranje ili vra¢anje nije moguce dovrsiti.

Obratite se lokalnom predstavniku u svojoj zemlji (pogledajte odjeljak Pomo¢ na stranici 2).

Vracanje baze podataka ne uspijeva

Datoteka sigurnosne kopije baze podataka koju pokusavate koristiti za vracanje je ostecena.

Pokusajte izvrsiti vra¢anje s nekom drugom datotekom sigurnosne kopije.
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Deinstalacija softvera

Ako Zelite deinstalirati CareLink Pro, poduzmite sljedece korake:

1

Otvorite odjeljak Control Panel (Upravljacka plo¢a) putem izbornika Start u sustavu
Windows.

Odaberite Add or Remove Programs (Dodavanje ili uklanjanje programa). Prikazuje se
prozor "Add or Remove Programs" (Dodavanje ili uklanjanje programa) u sustavu Windows.

Pomaknite se dolje do programa Medtronic CarelLink Pro i kliknite ga.
Kliknite Ukloni. Prikazuje se Install Shield Wizard (Carobnjak za instalaciju).

Kliknite Next (Dalje). Prikazuje se poruka u kojoj morate potvrditi da Zelite ukloniti
program.

Kliknite Yes (Da). Pokrece se program za deinstalaciju koji s raCunala uklanja program i sve
njegove datoteke. Po zavrsetku deinstalacije na zaslonu ¢arobnjaka prikazuje se poruka koja
potvrduje deinstalaciju.

Kliknite Finish (Zavrsi).
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Tablica s ikonama

Ikone i simboli na ambalaznim naljepnicama i opremi opisani su u sljedecoj tablici:

Jedan komad po kutiji/pakiranju

Pogledajte upute za upotrebu D}]

Kataloski broj REF
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CSV podaci

Kada izvozite podatke iz programa Carelink Pro, oni se izvoze u .csv datoteku. Ta se datoteka
moze uvesti u aplikaciju koja koristi radne listove, kao Sto je Microsoft Excel. U definicijama
stupaca u CSV datoteci mozZete pronaci potpuni opis podataka koji mogu biti sadrzani u CSV

datoteci.

CSV datoteka sadrzi ime i identifikaciju bolesnika i razdoblje izvjeScivanja te identificira sve
uredaje koji se nalaze u izvjescu.

Definicije podataka u stupcima

Index (Kazalo) Redoslijed kojim su podaci snimljeni na uredaj.

Time (Vrijeme) Vrijeme u koje su podaci snimljeni na ureda;j.

Ocitanje razine glukoze u krvi zabiljezeno mjeracem,
monitorom Guardian ili pumpom. Ako podaci potjecu
iz pumpe ili monitora Guardian, u tom je stupcu
prikazana ru¢no izmjerena razina glukoze u krvi i
razina primljena s povezanog mjeraca.

BG Reading (mg/dL or mmol/L) (O¢itanje glukoze u
krvi (mmol/L ili mg/dL))

Brzina isporuke aktivnog bazalnog inzulina u

Basal Rate (U/h) (Bazalna stopa (J/h)) jedinicama po satu,

Temp Basal Type (Vrsta priviemenog bazalnog Namjestanje vrste privremenog bazalnog inzulina
inzulina) (stopa inzulina ili postotak bazalnog).

Vrsta isporuke bolusnog inzulina [normalni, ¢etvrtasti,

Bolus Type (Vrsta bolusa) dvojni (normalni dio) ili dvojni (Cetvrtasti dio)].
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Bolus Volume Delivered (U) (Isporucena koli¢ina bolusa

)

Prime Type (Vrsta pocetnog ciklusa)

Broj jedinica inzulina koje su zapravo isporuc¢ene
tijekom isporuke inzulina u bolusu.

Rucni ili fiksni. Ru¢ni pocetni ciklus koristi se samo
nakon prematanja, za ispunjavanje kompleta
infuzijskih cijevi inzulinom prije uvodenja. Fiksno
pokretanje koristi se nakon umetanja cijevi za infuziju
za ispunjavanje meke kanile inzulinom nakon
uklanjanja igle uvodnika.

Alarm Naziv alarma koji se aktivirao.

Rewind (Prematanje)

BWZ Target High BG (mmol/L ili mg/dL) (Gornja ciljna
razina glukoze u krvi za BWZ (mmol/L ili mg/dL))

BWZ Carb Ratio (Omjer ugljikohidrata za BWZ)

BWZ Carb Input (Unos ugljikohidrata za BWZ)

BWZ Correction Estimate (U) (Ispravak procjene BWZ-a
)

BWZ Active Insulin (U) (Aktivni inzulin za BWZ (J))

Datum i sat kada je uredaj premotan.

Postavke za gornji dio raspona ciljne razine glukoze u
krvi koje koristi znacajka ¢arobnjaka za bolus (Bolus
Wizard).

Postavka za omjer inzulina i ugljikohidrata. Ako se kao
jedinice koriste grami, omjer je broj grama pokriven
jednom jedinicom inzulina. Ako se kao jedinice koriste
razmjene, omjer je broj jedinica inzulina potreban za
pokrivanje jedne razmjene.

Koli¢ina ugljikohidrata unesena u ¢arobnjak za bolus
(Bolus Wizard) koja se koristi za procjenu bolusa.

Jedinice inzulina u bolusu radi korekcije razine glukoze
u krvi, izracunate pomocu znacajke ¢arobnjaka za
bolus (Bolus Wizard).

Koli¢ina aktivnog inzulina izracunata kao preostala u
tijelu iz prijasnjih isporuka inzulina u bolusu pri
odredivanju procijenjene koli¢ine bolusa putem
znacajke carobnjaka za bolus (Bolus Wizard).
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Sensor Glucose (mmol/L or mg/dL) (Glukoza na

senzoru (mmol/L ili mg/dL)) Vrijednost glukoze senzora.

ISIG value (Vrijednost ISIG) nanoamperima (nA)

Ulazni signali (ISIG) koje ocitava senzor, izrazeni u

Vise pojedinosti o CSV datotekama koje izvozi CareLink Pro

Naslov na vrhu CSV datoteke obuhvaca sljedece:

« ime bolesnika

«  popis odabranih uredaja i njihovih serijskih brojeva
« odabrani raspon datuma

Svaki blok stupaca ima naslov koji obuhvaca sljedece:
«  naziv uredaja na koji se blok podataka primjenjuje

«  serijski broj tog uredaja

Ako se podaci ne prikazuju prema ocekivanjima

Brojni razliciti faktori mogu uzrokovati da drukdiji prikaz CSV podataka od ocekivanoga.

«  Promjene datuma ili vremena na uredaju mogu promijeniti redoslijed zapisa ili uzrokovati

prikaz zapisa izvan odabranog raspona datuma.

«  Ako izmedu (Citanja uredaja postoji veliki razmak, podaci za taj uredaj mogu biti prikazani u

vise blokova.
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Rjecnik

A1C - Glikozilirani hemoglobin

Bazalna stopa inzulina - Postavka pumpe koja pruza trajnu infuziju inzulina radi odrzavanja
stabilne razine glukoze u krvi izmedu obroka i tijekom noc¢i. Bazalni inzulin oponasa isporuku
inzulina iz gusterace, koja ispunjava sve potrebe tijela za inzulinom nevezane za hranu.

Bazalni inzulin - Infuzija inzulina koju automatski svakog sata isporucuje inzulinska pumpa na
temelju unaprijed programiranih profila i personaliziranih stopa postavljenih u pumpi. Pumpa
isporucuje dnevnu infuziju inzulina koja obi¢no pokriva "pozadinske" potrebe za inzulinom
tijekom razdoblja posta (primjerice tijekom no¢i i izmedu obroka).

Bolus éetvrtastog vala (Square Wave® bolus) - Bolus koji se isporu¢uje ravnomjerno tijekom
odredenog vremenskog razdoblja (30 minuta do osam sati).

Bolus dvostrukog vala (Dual Wave® bolus) - Kombinacija normalnog bolusa, koji se odmah
isporucuje, i Cetvrtastog (Square Wave) bolusa. Cetvrtasti se dio ravnomjerno isporucuje
tijekom odredenog vremenskog razdoblja.

Bolus hrane - Doza inzulina koja se daje za pokrivanje o¢ekivanog porasta glukoze u krvi do kojeg
dolazi nakon jela.

Bolus ispravljanja - Koli¢ina inzulina potrebna za povrat visoke razine glukoze u krvi natrag u ciljni
raspon.

CareLink’ Personal - Internetska usluga koja omogucuje upravljanje podacima o dijabetesu
putem interneta.

CH - Ugljikohidrati

ComLink - Uredaj za primopredaju radijskih frekvencija (RF) koji se koristi za preuzimanje
podataka iz pumpe Paradigm na racunalo.

Com-Station - Uredaj koji se koristi za preuzimanje podataka iz pumpe MiniMed 508 i prolaznih
podataka iz mjeraca drugih proizvodaca na racunalo.

Dio ¢etvrtastog vala (Square Wave) - (Sq) Drugi dio bolusa dvojnog vala (Dual Wave). Cetvrtasti
se dio ravnomjerno isporucuje tijekom odredenog vremenskog razdoblja nakon isporuke
trenutnog dijela.

Donja razina glukoze - Pumpa ¢e aktivirati alarm ako senzor upucuje na to da je glukoza korisnika
na senzoru jednaka toj vrijednosti ili veca od nje. Tu znacajku mozete ukljuciti i iskljuditi.

Easy Bolus™ - Metoda isporuke normalnog bolusa koristenjem gumba Easy Bolus na pumpi.

Ekspresni bolus - Metoda isporuke bilo koje vrste bolusa putem gumba express bolus (ekspresni
bolus) na pumpi.

Faktor korekcije bolusa - Koliko ¢e 1,0 jedinica inzulina spustiti vasu razinu glukoze u krvi. Taj se
faktor koristi za izracun koli¢ine bolusa ispravljanja u krvi kada je razina Secera u krvi visoka.
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(Razina glukoze u krvi) - (ciljna razina glukoze u krvi) = X. X + (faktor korekcije bolusa) = koli¢ina
korekcije bolusa.

GK - Kratica za glukozu u krvi

Gornja razina glukoze - Pumpa e aktivirati alarm ako senzor upucuje na to da je glukoza
korisnika na senzoru jednaka toj vrijednosti ili veca od nje. Tu znacajku mozete ukljuditi i
iskljuciti.

HbA1c - Glikozilirani hemoglobin.

Hiperglikemija - PoviSena razina glukoze u krvi ustanovljena nadzorom razina glukoze u krvi.
MozZe obuhvadati navedene simptome ili neke od njih: mu¢nina, povracanje, zamagljen vid,
glavobolja, Zelucane poteskoce, ¢esto mokrenje uz velike koli¢ine mokrace i letargija.

Hipoglikemija - Niska razina glukoze u krvi ustanovljena nadzorom razina glukoze u krvi. Moze
obuhvacati navedene simptome ili neke od njih: prekomjerna glad, drhtanje ili tremori,
znojenje, "plesuce” slike pred oc¢ima, vrtoglavica, glavobolja, nejasan govor, nagle promjene
raspoloZenija ili promjena osobnosti.

ID odaisilj. - Serijski broj odasiljaca koji se trenutno koristi.

Inzulin u bolusu - Doza inzulina koja se daje radi pokrivanja neocekivanog porasta glukoze u krvi
(primjerice nakon obroka ili meduobroka) ili za sniZavanje visoke razine glukoze na ciljani
raspon.

ISIG - Vrijednosti senzora iz kojih se vidi funkcionira li pravilno elektronika odasiljaca u sustavu
poboljsanom senzorima. Ako opazite vrijednost ISIG manju od 24,00 nA ili vecu od 29,00 nA,
zatrazite pomoc za proizvod. Mozda je vrijeme da zamijenite odasiljac.

Jedinice ugljikohidrata - Unos hrane pri koristenju ¢arobnjaka Bolus Wizard. Unosi se kao grami ili
razmjene (ugljikohidrata).

Komplet za infuziju - Uredaj koji se koristi za umetanje i ucvrscivanje kanile ispod kozZe i prijenos
inzulina na mjesto umetanja putem cjevcica iz pumpe.

Koncentracija inzulina - Snaga ili vrsta inzulina koji je lije¢nik prepisao korisniku. To utjece na
stopu inzulina koju pumpa isporucuje. Ako se koncentracija inzulina u korisnika promijeni,
potrebno je reprogramirati uzorke bazalnog inzulina te maksimalne stope bazalnog i bolusa u
pumpi.

Korak - Mjera inzulina koju postavite i koristite za isporuku putem znacajke Easy Bolus.

Maksimalni bazalni inzulin - Maksimalna koli¢ina bazalnog inzulina koju ¢e pumpa isporuciti u
danom trenutku. (Postavlja korisnik.)

Maksimalni bolus - Maksimalna koli¢ina inzulina u bolusu koji ¢e pumpa isporuciti u danom
trenutku. (Postavlja korisnik.)

Mjerac - Medicinski uredaj za odredivanje priblizne koncentracije glukoze u krvi. Kapljica krvi
stavlja se na jednokratnu testnu vrpcu koju mjerac ocitava i koristi za izracun razine glukoze u
krvi. Mjerac zatim prikazuje razinu u mmol/L ili mg/dL.

Mogucénost mjeraca - Znacajka koja pumpi omogucuje primanje ocitanja glukoze u krvi s
povezanog mjeraca razine glukoze u krvi.

Normalni bolus - Trenutna isporuka odredene jedini¢ne koli¢ine inzulina.

Omjer razmjene - Koli¢ina inzulina potrebna za pokrivanje jedne (1) razmjene ugljikohidrata.
(Pogledajte takoder: omjer ugljikohidrata.)

Omjer ugljikohidrata - Koli¢ina ugljikohidrata koju pokriva jedna jedinica inzulina. (Pogledajte
takoder: omjer razmjene.)

Osjetljivost inzulina - Koli¢ina u mmol/L (ili mg/dL) za koju jedna jedinica inzulina smanjuje
razinu glukoze u krvi (GUK). (Podaci iz ¢arobnjaka Bolus Wizard.)

Podrugéje ispod krivulje (engl. Area Under the Curve, AUC) - Oznacava koli¢inu visokih i niskih
izboja odredenih unaprijed postavljenim vrijednostima. Podaci o izboju oznacavaju frekvenciju
visokih ili niskih izboja. AUC upucuje na vaznost dogadaja tako sto prikazuje koliko su oniizvan
raspona te koliko dugo.
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Podsjetnik za kalibraciju - Pumpa ¢e automatski pokrenuti upozorenje mjeraca razine glukoze u
krvi do HH:MM svakih 12 sati i tako signalizirati da trenutna vrijednost kalibracije nije valjana.
Vrijednost podsjetnika za kalibraciju jest vremensko razdoblje prije isteka trenutne kalibracijske
vrijednosti prema kojoj korisnik zeli podsjetnik za kalibraciju. Ako je, primjerice, podsjetnik za
kalibraciju postavljen na dva sata, upozorenje mjeraca razine glukoze u krvi do HH:MM aktivirat
Ce se dva sata prije no 5to je potrebno izvrsiti kalibraciju.

Postotak srednje apsolutne razlike (MAD%) - Predstavlja razinu to¢nosti pri kalibraciji senzora
prema ocitanjima GUK-a s mjeraca. Sto je taj broj niZi, to je veca to¢nost kalibracije. MAD% se
izraCunava tako da se razlika izmedu bliskih parova glukoze sa senzora i o¢itanja GUK-a s
mjeraca dijeli s o¢itanjem GUK-a s mjeraca, a zatim se izracuna prosjek svih parova.

Prekid - Funkcija pumpe koja zaustavlja svu isporuku inzulina. Isporuke trenutnog bolusa i/ili
pocetnog ciklusa se otkazuju. Isporuka bazalnog inzulina zaustavlja se do ponovnog
pokretanja.

Prijenos - Postupak prijenosa podataka iz pumpe ili mjeraca na posluzitelj sustava CareLink®
Personal.

Priv. - Privremeno.

Privremeni bazalni (priv. bazalni) - Privremeni jednokratni bazalni inzulin odredene koli¢ine i
trajanja. Koristi se za ispunjavanje potreba za inzulinom za posebne aktivnosti ili uvjete koji nisu
dio normalne dnevne rutine.

Profil bazalnog inzulina - Stopa bazalnog inzulina s vriemenom pocetka i zavrsetka. Korisnici
mogu programirati nekoliko razlicitih profila u svoju pumpu uz razli¢itu stopu bazalnog inzulina
za svaki profil tijekom 24 sata radi postizanja boljeg nadzora nad razinom glukoze.

RF - Radijska frekvencija (RF).

Rucni bolus - Dodatna stavka dostupna na izborniku BOLUS MENU kada je znacajka ¢arobnjaka
Bolus Wizard aktivna. Metoda programiranja bolusa bez ¢arobnjaka Bolus Wizard.

Test A1C - Test za hemoglobin A1C koristi se za tumacenije razine glukoze u krvi tijekom
odredenog vremenskog razdoblja.

Test HbA1c - Test za hemoglobin A1C koristi se za tumacenje razine glukoze u krvi ili prosjeka
razine tijekom razdoblja od dva do tri mjeseca.

Test na ketone - Ketoni su otpad koji se stvara kada je tijelo prisiljeno sagorijevati tjelesnu mast
umjesto glukoze radi dobivanja energije. To moze biti znak nedostatka inzulina u tijelu. Test na
ketone mijeri koli¢inu ketona koncentriranu u krvi ili urinu.

Upozorenje da je rezervoar na niskoj razini - Programibilno upozorenje koje se pojavljuje kada
odredeni broj jedinica ostane u rezervoaru pumpe ili kada preostane odredeno vrijeme prije
praznjenja rezervoara.

Uzorak, standardni - Vas normalni bazalni inzulin koji podrzava svakodnevne aktivnosti. Kada je
znacajka Patterns (Uzorci) isklju¢ena, pumpa koristi standardni (bazalni) uzorak.

Uzorci bazalnog inzulina - Korisnici mogu programirati do tri razli¢ita uzorka stope bazalne doze
U svoju pumpu za isporuku bazalnog inzulina: standardni uzorak, uzorak A i uzorak B. Za svaki
uzorak moguce je postaviti do 48 stopa bazalnog inzulina.

Veza
(1) Sluzi za iskljucivanje i postavljanje mogu¢nosti mjeraca koja pumpi omogucuje primanje
ocitanja glukoze u krvi s povezanog mjeraca.

(2) Koristi se i u sustavu za referencu na hipertekstne veze. Kada kliknete hipertekstne veze, one
vas vode do nekog drugog mjesta u sustavu ili na neko drugo web-mjesto.

Znacajka uzorka - Prosirena znacajka pumpe koja omogucuje programiranje dodatnih bazalnih
doza (uzorak A, uzorak B) koje podrzavaju aktivnosti ili uzorke glukoze koji nisu dio vase
svakodnevne rutine, no uobicajeni su dio vaseg Zivotnog stila. Takve aktivnosti mogu
obuhvacdati sport jednom tjedno, promjenu navika spavanja tijekom vikenda ili hormonalne
promjene tijekom menstruacijskog ciklusa.

Zvuk bolusa - Pumpu je moguce programirati tako da korisnik ¢uje zvuk kada odabere koli¢inu
inzulina u bolusu (0,5 ili 1,0 jedinica) za isporuku. To je korisno u situacijama kada je tesko
vidjeti gumbe na pumpi.
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